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Preface

How to Use This Guide

About the System  The guides listed below are shipped with the Applied Biosystems 7500/7500 Fast

Documentation

Real-Time PCR System (7500/7500 Fast system).

Time PCR System Site Preparation Guide

7500/7500 Fast system.

Intended for personnel who schedule, manage, and perform the
tasks required to prepare your site for installation of the
7500/7500 Fast system.

Guide Purpose and Audience PN
Applied Biosystems 7500/7500 Fast Real- | Explains how to perform experiments on the 7500/7500 Fast 4387784
Time PCR System Getting Started Guide system. Each Getting Started Guide functions as both a:
for Genotyping Experiments e Tutorial, using example experiment data provided with the
Applied Biosystems 7500/7500 Fast Real- gpﬁ“ed B';’g%gtemff 7500/7500 Fast Real-Time PCR 4387785
Time PCR System Getting Started Guide ottware ( SO ware)..
for Presence/Absence Experiments e Guide for your own experiments.
. ; Intended for laboratory staff and principal investigators who
Applied Biosystems 7500/7500 Fast Real- . - 4387783
Time PCR System Getting Started Guide perform experiments using the 7500/7500 Fast system.
for Relative Standard Curve and
Comparative Cy Experiments
Applied Biosystems 7500/7500 Fast Real- 4387779
Time PCR System Getting Started Guide
for Standard Curve Experiments
Applied Biosystems 7500/7500 Fast Real- | Explains how to maintain the 7500/7500 Fast system. 4387777
Time PCR System Maintenance Guide Intended for laboratory staff responsible for the maintenance of
Applied Biosystems 7500/7500 Fast Real- | the 7500/7500 Fast system. 4387778
Time PCR System Computer Setup Guide
Applied Biosystems Real-Time PCR Provides information about the reagents you can use on 4387787
Systems Reagent Guide Applied Biosystems Real-Time PCR Systems, including:
¢ An introduction to TagMan® and SYBR® Green reagents
¢ Descriptions and design guidelines for the following
experiment types:
— Quantitation experiments
— Genotyping experiments
— Presence/absence experiments
Intended for laboratory staff and principal investigators who
perform experiments using the 7500/7500 Fast system.
Applied Biosystems 7500/7500 Fast Real- | Explains how to prepare your site to receive and install the 4387776

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence
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Preface
How to Use This Guide

Guide Purpose and Audience PN

Applied Biosystems 7500/7500 Fast Real- | Explains how to use the 7500 software to: NA

Time PCR Software v2.0 Help e Set up, run, and analyze experiments using the 7500/7500

Fast system.
e (Calibrate a 7500/7500 Fast instrument.

¢ Verify that the performance of a 7500/7500 Fast instrument
with an RNase P run.

Intended for:

* Laboratory staff and principal investigators who perform
experiments using the 7500/7500 Fast system.

e Laboratory staff responsible for the installation and
maintenance of the 7500/7500 Fast system.

Assumptions This guide assumes that you:
+ Are familiar with the Microsoft Windows® operating system.
* Are familiar with the Internet and Internet browsers.
* Know how to handle DNA and/or RNA samples and prepare them for PCR.
» Understand data storage, file transfer, and copying and pasting.

* Have networking experience, if you plan to integrate the 7500/7500 Fast system
into your existing laboratory data flow.

Text Conventions  This guide uses the following conventions:
* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.
* [talic text indicates new or important words and is also used for emphasis. For example:
Before analyzing, always prepare fresh matrix.

* A right arrow symbol ( » ) separates successive commands you select from a drop-down
or shortcut menu. For example:

Select File » Open.

User Attention  Two user attention words appear in Applied Biosystems user documentation. Each word
Words implies a particular level of observation or action as described below:

Note: Provides information that may be of interest or help but is not critical to the use of
the product.

IMPORTANT! Provides information that is necessary for proper instrument operation,
accurate reagent kit use, or safe use of a chemical.

Examples of the user attention words appear below:

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection, you need a valid user ID.

viii Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence
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How to Obtain More Information

Safety Alert  Safety alert words also appear in user documentation. For more information, see “Safety
Words  Alert Words” on page xii.

How to Obtain More Information

Related Documents Related to Genotyping Experiments
Documentation

Document PN

Allelic Discrimination Pre-Developed TagMan® Assay Reagents Quick Reference 4312212

Card

Custom TagMan® Genomic Assays Protocol Submission Guidelines 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Ordering TagMan® SNP Genotyping Assays Quick Reference Card 4374204

Performing a Custom TagMan® SNP Genotyping Assay for 96-Well Plates Quick 4371394
Reference Card

Performing a TagMan® Drug Metabolism Genotyping Assay for 96-Well Plates 4367636
Quick Reference Card

Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
TagMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® SNP Genotyping Assays Protocol 4332856

Documents Related to Presence/Absence Experiments

Document PN
DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal 4343586
Swabs Protocol
NucPrep® Chemistry: Isolation of Genomic DNA from Animal and Plant Tissue 4333959
Protocol

Documents Related to Relative Standard Curve and Comparative C; Experiments

Document PN
Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence ix
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How to Obtain More Information

Documents Related to Standard Curve Experiments

Document PN
Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Documents Related to the Reagent Guide
Document PN
Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Custom TagMan® Gene Expression Assays Protocol 4334429
Custom TaqgMan® Genomic Assays Protocol: Submission Guidelines 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Power SYBR® Green PCR Master Mix and RT-PCR Protocol 4367218
Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
Primer Express® Software Version 3.0 Getting Started Guide 4362460
SYBR® Green PCR and RT-PCR Reagents Protocol 4304965
SYBR® Green PCR Master Mix and RT-PCR Reagents Protocol 4310251
TagMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® Exogenous Internal Positive Control Reagents Protocol 4308335
TagMan® Fast Universal PCR Master Mix (2X) Protocol 4351891
TagMan® Gene Expression Assays Protocol 4333458
TagMan® Gene Expression Master Mix Protocol 4371135
TagMan® Genotyping Master Mix Protocol 4371131
TagMan® SNP Genotyping Assays Protocol 4332856
TagMan® Universal PCR Master Mix Protocol 4304449
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Using TagMan® Endogenous Control Assays to Select an Endogenous Control 127AP08
for Experimental Studies Application Note
Note: For more documentation, see “How to Obtain Support” on page xi.
X Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence
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Preface
How to Obtain Support

The 7500 Software Help describes how to use each feature of the user interface. Access
the Help from within the software by doing one of the following:

¢ Press F1.
e Click @ in the toolbar.
» Select Help » 7500 Software Help.

To find topics of interest in the Help:
» Review the table of contents.

» Search for a specific topic.
+ Search the alphabetized index.

Applied Biosystems welcomes your comments and suggestions for improving its user
documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is only for submitting comments and
suggestions relating to documentation. To order documents, download PDF files, or for
help with a technical question, go to http://www.appliedbiosystems.com, then click the
link for Support. (See “How to Obtain Support” on page xi).

How to Obtain Support

For the latest services and support information for all locations, go to
http://www.appliedbiosystems.com, then click the link for Support.
At the Support page, you can:

» Search through frequently asked questions (FAQs)

* Submit a question directly to Technical Support

* Order Applied Biosystems user documents, MSDSs, certificates of analysis, and
other related documents

* Download PDF documents
* Obtain information about customer training
* Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers
to contact Applied Biosystems Technical Support and Sales facilities.

IMPORTANT! When directed to do so by this guide, or when you need to schedule
maintenance for your 7500/7500 Fast instrument (such as annual planned maintenance
or temperature verification/calibration), contact the Applied Biosystems Care Center. To
obtain a phone number for or to send an e-mail to the center, go to
http://www.appliedbiosystems.com/support/contact.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence Xi
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Preface

Safety Conventions Used in This Document

Safety Conventions Used in This Document

Safety Alert  Four safety alert words appear in Applied Biosystems user documentation at points in
Words the document where you need to be aware of relevant hazards. Each alert

word—-IMPORTANT, CAUTION, WARNING, DANGER-implies a particular level
of observation or action, as defined below:
Definitions
IMPORTANT! — Indicates information that is necessary for proper instrument operation,
accurate chemistry kit use, or safe use of a chemical.
A (O.\I[e]\] — Indicates a potentially hazardous situation that, if not avoided, may
result in minor or moderate injury. It may also be used to alert against unsafe practices.
A \WLGIINel — Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.
A prNeldi] — Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury. This signal word is to be limited to the most
extreme situations.
Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard icons that are affixed to Applied Biosystems
instruments (see “Safety Symbols” on page xiii).
Examples
The following examples show the use of safety alert words:
IMPORTANT! Wear powder-free gloves when you handle the halogen lamp.
A (A0} The lamp is extremely hot. Do not touch the lamp until it has cooled to
room temperature.
A WWLGIWINe] CHEMICAL HAZARD. Ethanol is a flammable liquid and vapor.
Exposure causes eye, skin, and respiratory tract irritation and may cause central nervous
system depression and liver damage. Read the MSDS, and follow the handling instructions.
Wear appropriate protective eyewear, clothing, and gloves.
A PL\[e]1338] ELECTRICAL HAZARD. Failure to ground the instrument properly
can lead to an electrical shock. Ground the instrument according to the provided instructions.

Xii Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence
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Symbols on Instruments

Symbols on Instruments

Electrical The following table describes the electrical symbols that may be displayed on
Symbols on  Applied Biosystems instruments.

Instruments
Symbol Description Symbol Description
Indicates the On position of the I Indicates a terminal that may be
main power switch. — connected to the signal ground
= reference of another instrument.

This is not a protected ground
terminal.

main power switch. terminal that must be connected
to earth ground before any other
electrical connections are made
to the instrument.

Indicates the Off position of the @ Indicates a protective grounding

Indicates a standby switch by Indicates a terminal that can
which the instrument is switched receive or supply alternating
on to the Standby condition. current or voltage.
Hazardous voltage may be
present if this switch is on
standby.

C O

Indicates the On/Off position of a pr— Indicates a terminal that can
push-push main power switch. L receive or supply alternating or
direct current or voltage.

S

Safety Symbols The following table describes the safety symbols that may be displayed on
Applied Biosystems instruments. Each symbol may appear by itself or in combination
with text that explains the relevant hazard (see “Safety Labels on Instruments” on
page xiv). These safety symbols may also appear next to DANGERS, WARNINGS, and
CAUTIONS that occur in the text of this and other product-support documents.

Description

Indicates that you should consult the manual for further information and to
proceed with appropriate caution.

Indicates the presence of an electrical shock hazard and to proceed with
appropriate caution.

Indicates the presence of a hot surface or other high-temperature hazard and
to proceed with appropriate caution.

Indicates the presence of a laser inside the instrument and to proceed with
appropriate caution.

Indicates the presence of moving parts and to proceed with appropriate
caution.

> BB

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence Xiii
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Safety Labels on Instruments

Environmental
Symbols on
Instruments

The following symbol applies to all Applied Biosystems electrical and electronic
products placed on the European market after August 13, 2005.

Symbol Description
L=, Do not dispose of this product as unsorted municipal waste. Follow local
4 municipal waste ordinances for proper disposal provisions to reduce the
\ N’ I environmental impact of waste electrical and electronic equipment (WEEE).
—a European Union customers:
Call your local Applied Biosystems Customer Service office for equipment
— pick-up and recycling. See http://www.appliedbiosystems.com for a list of

customer service offices in the European Union.

Safety Labels on Instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on
Applied Biosystems instruments in combination with the safety symbols described in the

preceding section.

English

Francais

CAUTION Hazardous chemicals. Read the
Material Safety Data Sheets (MSDSs) before
handling.

CAUTION Hazardous waste. Refer to
MSDS(s) and local regulations for handling
and disposal.

ATTENTION Produits chimiques
dangeureux. Lire les fiches techniques de
sUreté de matériels avant la manipulation des
produits.

ATTENTION Déchets dangereux. Lire les
fiches techniques de sirreté de matériels et la
régulation locale associées a la manipulation
et I'élimination des déchets.

WARNING Hot lamp.

AVERTISSEMENT Lampe brilante.

WARNING Hot. Replace lamp with an
Applied Biosystems lamp.

AVERTISSEMENT Composants brdlants.
Remplacer la lampe par une lampe
Applied Biosystems.

CAUTION Hot surface.
DANGER High voltage.

ATTENTION Surface br(lante.
DANGER Haute tension.

WARNING To reduce the chance of electrical
shock, do not remove covers that require tool
access. No user-serviceable parts are inside.
Refer servicing to Applied Biosystems
qualified service personnel.

AVERTISSEMENT Pour éviter les risques
d'électrocution, ne pas retirer les capots dont
I'ouverture nécessite I'utilisation d'outils.
L’instrument ne contient aucune piéce
réparable par I’ utilisateur. Toute intervention
doit étre effectuée par le personnel de service
qualifié de Applied Biosystems.

CAUTION Moving parts.

ATTENTION Parties mobiles.

WARNING This instrument is designed for
12V, 75 W Halogen lamps only.

AVERTISSEMENT Cet instrument est congu
pour des lampes d'halogene de 12 Vet 75 W
seulement.

Xiv Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence
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Safety Labels on Instruments

Locations of The Applied Biosystems 7500/7500 Fast Real-Time PCR System contains warnings at
Warnings the locations shown below.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence XV
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General Instrument Safety

General Instrument Safety

Moving and
Lifting the
Instrument

Moving and
Lifting Stand-

Alone Computers

and Monitors

Operating the
Instrument

Cleaning or

Decontaminating

XVi

the Instrument

AWARNING PHYSICAL INJURY HAZARD. Use this product only as

specified in this document. Using this instrument in a manner not specified by
Applied Biosystems may result in personal injury or damage to the instrument.

A (o7:\8]1(e)'] PHYSICAL INJURY HAZARD. The instrument is to be moved

and positioned only by the personnel or vendor specified in the applicable site
preparation guide. If you decide to lift or move the instrument after it has been installed,
do not attempt to lift or move the instrument without the assistance of others, the use of
appropriate moving equipment, and proper lifting techniques. Improper lifting can cause
painful and permanent back injury. Depending on the weight, moving or lifting an
instrument may require two or more persons.

AWARNING Do not attempt to lift or move the computer or the monitor without

the assistance of others. Depending on the weight of the computer and/or the monitor,
moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:

» Make sure that you have a secure, comfortable grip on the computer or the monitor
when lifting.

» Make sure that the path from where the object is to where it is being moved is clear
of obstructions.

* Do not lift an object and twist your torso at the same time.

» Keep your spine in a good neutral position while lifting with your legs.

» Participants should coordinate lift and move intentions with each other before
lifting and carrying.

* Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Ensure that anyone who operates the instrument has:
* Received instructions in both general safety practices for laboratories and specific
safety practices for the instrument.

* Read and understood all applicable Material Safety Data Sheets (MSDSs). See
“About MSDSs” on page xvii.

AWARNING PHYSICAL INJURY HAZARD. Use this instrument as specified

by Applied Biosystems. Using this instrument in a manner not specified by
Applied Biosystems may result in personal injury or damage to the instrument.

A (O.\I[el\] Before using a cleaning or decontamination method other than those

recommended by the manufacturer, verify with the manufacturer that the proposed
method will not damage the equipment.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence
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Chemical Safety

Chemical Safety

Chemical Hazard AWARNING CHEMICAL HAZARD. Before handling any chemicals, refer to

Warning the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all
relevant precautions.

A LGN el CHEMICAL HAZARD. All chemicals in the instrument, including

liquid in the lines, are potentially hazardous. Always determine what chemicals have
been used in the instrument before changing reagents or instrument components. Wear
appropriate eyewear, protective clothing, and gloves when working on the instrument.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or store waste

in a glass container because of the risk of breaking or shattering. Reagent and waste
bottles can crack and leak. Each waste bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent
and waste bottles.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with the
first shipment of a hazardous chemical to a customer after an MSDS has been updated.
MSDSs provide the safety information you need to store, handle, transport, and dispose
of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to
replace the appropriate MSDS in your files.

Obtaining MSDSs The MSDS for any chemical supplied by Applied Biosystems is available to you free
24 hours a day. To obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then click MSDS Search.

2. In the Keyword Search field, enter the chemical name, product name, MSDS part
number, or other information that appears in the MSDS of interest. Select the
language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of the
following:
* Open — To view the document
* Print Target — To print the document
» Save Target As — To download a PDF version of the document to a destination
that you choose

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence Xvii
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Chemical Safety

Chemical Safety To minimize the hazards of chemicals:

Xviii

Guidelines .

Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page xvii.)

Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For additional safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended on the MSDS.

Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence
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Chemical Waste Safety

Chemical Waste Safety

Chemical Waste A (X1[e]f] HAZARDOUS WASTE. Refer to Material Safety Data Sheets and
Hazard local regulations for handling and disposal.

AWARNING CHEMICAL WASTE HAZARD. Wastes produced by Applied

Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or store waste in a

glass container because of the risk of breaking or shattering. Reagent and waste bottles can
crack and leak. Each waste bottle should be secured in a low-density polyethylene safety
container with the cover fastened and the handles locked in the upright position. Wear
appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

Chemical Waste To minimize the hazards of chemical waste:

Safety Guidelines * Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle, or
dispose of chemical waste.

* Provide primary and secondary waste containers. (A primary waste container holds
the immediate waste. A secondary container contains spills or leaks from the
primary container. Both containers must be compatible with the waste material and
meet federal, state, and local requirements for container storage.)

* Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For additional safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

* Handle chemical wastes in a fume hood.
» After emptying the waste container, seal it with the cap provided.

+ Dispose of the contents of the waste tray and waste bottle in accordance with good
laboratory practices and local, state/provincial, or national environmental and
health regulations.

Waste Disposal If potentially hazardous waste is generated when you operate the instrument, you must:

* Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

* Ensure the health and safety of all personnel in your laboratory.

* Ensure that the instrument waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and
disposal limitations may apply.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence Xix
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Electrical Safety

Fuses

Power

Overvoltage
Rating

A pZEW[e]33] ELECTRICAL SHOCK HAZARD. Severe electrical shock can
result from operating the Applied Biosystems 7500/7500 Fast Real-Time PCR System
without its instrument panels in place. Do not remove instrument panels. High-voltage
contacts are exposed when instrument panels are removed from the instrument.

AWARNING FIRE HAZARD. Improper fuses or high-voltage supply can
damage the instrument wiring system and cause a fire. Before turning on the instrument,
verify that the fuses are properly installed and that the instrument voltage matches the
power supply in your laboratory.

AWARNING FIRE HAZARD. For continued protection against the risk of fire,
replace fuses only with fuses of the type and rating specified for the instrument.

A pWNelai] ELECTRICAL HAZARD. Grounding circuit continuity is vital for

the safe operation of equipment. Never operate equipment with the grounding conductor
disconnected.

A pNel3i] ELECTRICAL HAZARD. Use properly configured and approved
line cords for the voltage supply in your facility.

A PLW[e]J3] ELECTRICAL HAZARD. Plug the system into a properly
grounded receptacle with adequate current capacity.

The Applied Biosystems 7500/7500 Fast Real-Time PCR System has an installation
(overvoltage) category of II, and is classified as portable equipment.

Physical Hazard Safety

Moving Parts

XX

éWARNING PHYSICAL INJURY HAZARD. Moving parts can crush and cut.

Keep hands clear of moving parts while operating the instrument. Disconnect power
before servicing the instrument.
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Biological Hazard Safety

General &WARNING BIOHAZARD. Biological samples such as tissues, body fluids,

Biohazard infectious agents, and blood of humans and other animals have the potential to transmit
infectious diseases. Follow all applicable local, state/provincial, and/or national
regulations. Wear appropriate protective equipment, which includes but is not limited to:
protective eyewear, face shield, clothing/lab coat, and gloves. All work should be
conducted in properly equipped facilities using the appropriate safety equipment (for
example, physical containment devices). Individuals should be trained according to
applicable regulatory and company/institution requirements before working with
potentially infectious materials. Read and follow the applicable guidelines and/or
regulatory requirements in the following:

* U.S. Department of Health and Human Services guidelines published in Biosafety
in Microbiological and Biomedical Laboratories (stock no. 017-040-00547-4;
bmbl.od.nih.gov)

* Occupational Safety and Health Standards, Bloodborne Pathogens (29 CFR
§1910.1030; www.access.gpo.gov/ nara/cfr/waisidx_01/29¢fr1910a_01.html).

* Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:

www.cdc.gov

Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such
as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your
workstation to promote neutral or relaxed working positions.

A (o701 1[o)\] MUSCULOSKELETAL AND REPETITIVE MOTION

HAZARD. These hazards are caused by potential risk factors that include but are not
limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy
positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

» Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.
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Safety and Electromagnetic Compatibility (EMC) Standards

U.S. and
Canadian Safety
Standards

c(UL)us

Canadian EMC
Standard

European Safety
and EMC
Standards

C€

Australian EMC
Standards

C

XXii

This section provides information on:
» U.S. and Canadian Safety Standards
» Canadian EMC Standard
» European Safety and EMC Standards
* Australian EMC Standards

This instrument has been tested to and complies with standard UL 61010A-1, “Safety
Requirements for Electrical Equipment for Laboratory Use, Part 1: General
Requirements” and with standard UL 61010-2-010, “Particular Requirements for
Laboratory Equipment for the Heating of Materials.”

This instrument has been tested to and complies with standard CSA 1010.1, “Safety
Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use,
Part 1: General Requirements.”

This instrument has been tested to and complies with ICES-001, Issue 3: Industrial,
Scientific, and Medical Radio Frequency Generators.

Safety

This instrument meets European requirements for safety (Low Voltage Directive
2006/95/EC). This instrument has been tested to and complies with standards EN 61010-
1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and
Laboratory Use, Part 1: General Requirements” and EN 61010-2-010, “Particular
Requirements for Laboratory Equipment for the Heating of Materials,” and with
standard EN 61010-2-081:2002+A1:2003 “Particular Requirements for Automatic and
Semi-Automatic Laboratory Equipment for Analysis and Other Purposes.”

EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 2004/108/EC). This instrument has been tested to and complies with standard
EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and
Laboratory Use — EMC Requirements.”

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits
and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial,
Scientific, and Medical (ISM) Radio-frequency Equipment.”
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Chapter 1

Get Started

This chapter covers:

About the 7500/7500 Fast System . ..........o i 2
Supported Consumables . .. ...t 4
About Presence/Absence Experiments. .. ..., 7
How to Use This Guide. . . . ... .. i 11
About the Example Presence/Absence Experiment . .. ..................... 12
Example Experiment Workflow .. ........ ... ... ... ... ... .. .. ... .. . ... 14

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.
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About the 7500/7500 Fast System

The Applied Biosystems 7500/7500 Fast Real-Time PCR System is a 96-well, five-color
platform that uses fluorescence-based polymerase chain reaction (PCR) reagents to provide:

* Quantitative detection of target nucleic acid sequences (targets) using real-time
analysis.

* Qualitative detection of targets using post-PCR (endpoint) analysis.

* Qualitative analysis of the PCR product (achieved by melt curve analysis that occurs
post-PCR).

About Data The 7500/7500 Fast system collects raw fluorescence data at different points during a
Collection PCR, depending on the type of run that the instrument performs:

Run Type Data Collection Point

Real-time runs | Standard curve The instrument collects data after each extension
step of the PCR.

Relative standard curve

Comparative C; (AAC;)
Post-PCR Genotyping The instrument collects data:
(endpoint) runs Presence/absence ¢ Before the PCR (For presence/absence

experiments, data collection before the PCR is
optional but recommended.)

e (Optional) During the PCR. The instrument can
collect data during the run (real-time);
collecting data during the run can be helpful
for troubleshooting.

e After the PCR.

Regardless of the run type, a data collection point or read on the 7500/7500 Fast
instrument consists of three phases:

1. Excitation — The instrument illuminates all wells of the reaction plate within the
instrument, exciting the fluorophores in each reaction.

2. Emission — The instrument optics collect the residual fluorescence emitted from the
wells of the reaction plate. The resulting image collected by the device consists only
of light that corresponds to the range of emission wavelengths.

3. Collection — The instrument assembles a digital representation of the residual
fluorescence collected over a fixed time interval. The 7500 software stores the raw
fluorescence image for analysis.

After a run, the 7500 software uses region of interest (ROI), optical, dye, and background
calibrations to determine the location and intensity of the fluorescence in each read, the
dye associated with each fluorescence signal, and the significance of the signals.

Notes
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About the Filters The 7500/7500 Fast system uses the following filters:

Filter 1 2 3 4 S
e FAM™ dye e JOE™dye ¢ TAMRA™dye | ® ROX™dye | Cy5®dye
Dye e SYBR®Green | o VIC®dye | ¢ NED"dye ¢ Texas Red®
dye e Cy3®dye dye

For More For information on:

Information * The 7500/7500 Fast system — Refer to the Applied Biosystems 7500/7500 Fast Real-
Time PCR System Software v2.0 Help.

Note: To access the Help, select Help » 7500 Software Help in the 7500 software.

* Genotyping experiments — Refer to the Applied Biosystems 7500/7500 Fast Real-
Time PCR System Getting Started Guide for Genotyping Experiments.

» Relative standard curve and/or comparative C (AAC) experiments — Refer to the
Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide
for Relative Standard Curve and Comparative C Experiments.

» Standard curve experiments — Refer to the Applied Biosystems 7500/7500 Fast Real-
Time PCR System Getting Started Guide for Standard Curve Experiments.

Notes
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Supported Consumables

7500 System  The 7500 system supports the consumables listed below.

Consumable Part Number
¢ MicroAmp® Optical 96-Well Reaction Plate with Barcode, 0.2-mL e 4306737
e MicroAmp™ Optical Adhesive Film e 4311971
¢ MicroAmp™ Optical 8-Tube Strip, 0.2-mL * 4316567
¢ MicroAmp™ Optical 8-Cap Strip e 4323032
* MicroAmp® Optical Tube without Cap, 0.2-mL e N8010933
¢ MicroAmp® Reaction Tube with Cap, 0.2-mL ¢ N8010540
¢ Microamp® Splash Free Support Base e N8010531
e MicroAmp™ Adhesive Film Applicator e 4333183
¢ MicroAmp® Cap Installing Tool (Handle) e 4330015
¢ MicroAmp™ Multi-Removal Tool e 4313950

# Consumable # Consumable

A | MicroAmp® Optical 96-Well Reaction Plate, E  MicroAmp™ Optical 8-Tube Strip
0.2-mL
Microamp® Splash Free Support Base F | MicroAmp® Optical Tube without Cap

C | MicroAmp™ Optical 8-Cap Strip, 0.2-mL G | MicroAmp™ Optical Adhesive Film
MicroAmp® Reaction Tube with Cap, 0.2-mL

Notes
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Supported Consumables

7500 Fast System  The 7500 Fast system supports the consumables listed below.

IMPORTANT! Use only Fast consumables (reaction plates, tube strips, and tubes) with
the 7500 Fast system, even when performing an experiment with standard reagents.

Consumable Part Number
¢ MicroAmp™ Fast Optical 96-Well Reaction Plate with Barcode, 0.1-mL e 4346906
¢ MicroAmp™ Optical Adhesive Film e 4311971
e MicroAmp™ Fast 8-Tube Strip, 0.1-mL e 4358293
e MicroAmp™ Optical 8-Cap Strip e 4323032
e Microamp® Splash Free Support Base e N8010531
e MicroAmp™ Adhesive Film Applicator e 4333183
e MicroAmp® Cap Installing Tool (Handle) e 4330015
¢ MicroAmp™ Multi-Removal Tool e 4313950

# Consumable
A | MicroAmp™ Fast Optical 96-Well Reaction Plate, 0.1-mL
B | Microamp® Splash Free Support Base
C | MicroAmp™ Optical 8-Cap Strip
| D | MicroAmp™ Fast 8-Tube Strip
E | MicroAmp™ Optical Adhesive Film

Notes
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Standard vs. Make sure that you use the correct reaction plate for your system:
Fast Reaction
Plates and Tubes System Reaction Plate

7500 system ¢ MicroAmp® Optical 96-Well Reaction Plate (PN 4306737, also called
standard reaction plates)

¢ MicroAmp® Optical Tubes without Caps, 0.2-mL (PN N8010933, also
called standard reaction tubes)

¢ MicroAmp® Reaction Tubes with Caps, 0.2-mL (PN N2070540)
e MicroAmp™ Optical 8-Tube Strip, 0.2-mL (PN 4316567, also called
standard reaction tube strips)

IMPORTANT! Fast reaction plates and tubes do not fit into the standard
sample block correctly and will result in loss of data.

7500 Fast e MicroAmp™ Fast Optical 96-Well Reaction Plate, (PN 43469086, also called
system Fast reaction plates)

¢ MicroAmp™ Fast 8-Tube Strip, 0.1-mL (PN 4358293, also called Fast
reaction tube strips)

IMPORTANT! Standard reaction plates and tube strips will not properly
function and might be crushed when using the Fast sample block.

Fast Reaction Plates Standard Reaction Plates
(PN 4346906) (PN 4306737)

‘— Notch at top-right
.. corner by A12

Notch at—
top-left
corner
by A1

ﬁf H | J T I T l
30-pL — 7T |I i |I [RYRYAY 'I YT II II I| II Il |I II |I | 100-pL
maximum TRRTRRT TERVERT] TRV RURTRVERY maximum
reaction reaction
volume volume
Notes
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About Presence/Absence Experiments

About Presence/Absence Experiments

Endpoint Presence/absence experiments are endpoint experiments. In endpoint experiments:
Experiments » Data are collected at the end of the PCR process.
* Reactions are characterized by the quantity of target accumulated at the end of PCR.
* The datapoint is the normalized intensity of the reporter dye, or Rn.

Note: Some endpoint experiments also include pre-PCR datapoints. If so, the system
calculates the delta Rn (ARn) value per the following formula:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized reporter

Note: In this guide, the term experiment refers to the entire process of performing a run
using the 7500/7500 Fast system, including setup, run, and analysis.

About Presence/ Perform a presence/absence experiment to detect a specific target in a sample.
Absence
Experiments

Supported The 7500/7500 Fast system supports the following reagents for presence/absence
Reagents experiments:

+ TagMan® reagents (page 8)
* Other fluorescent-based reagents (page 8)

Note: Presence/absence experiments are not supported for Fast master mix or Fast
protocols.

Notes
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About Presence/Absence Experiments

TagMan Reagents

TagMan reagents use a fluorogenic probe to enable detection of a target sequence

(unknown target) and IPC sequence (IPC target). During amplification, the unknown
target and the IPC target generate reporter fluorescence such that positive or negative
calls can be made on samples.

Note: If you use TagMan® reagents, the 7500 software automatically calculates reaction
volumes in the Reaction Setup screen.

TagMan® Reagents or Kits Process
Advantages PCR and Detection of cDNA
¢ Increased specificity with the addition of a & Assay Gomponents o
fluorogenic probe. T— PP privein
¢ Provides multiplex capability. S .
¢ Preformulated assays, optimized to run fumuu‘m LR HHMHH\@*:Z -~ ow
under universal thermal cycling conditions, g s
are available. ~g
R . . b. Denatured Template and Annealing of Assay Components -
Limitations S e LEGEND
Requires synthesis of a unique fluorogenic v G P
probe. - ST B) cuencher
c. Signal Generation AmpliTaq Gold®
DNA Polymerase
3 X
T T T ‘H ‘ HH 777777777 7 Probe
N Reverse primer e primer
Forward primer 7\59* MGB i
s LN e @ S Template
TN RO i
3 5 Extended Primer

Other Reagents

If you use fluorescence-based reagents other than TagMan® reagents, you must design
your experiment using Advanced Setup instead of the Design Wizard (see “Advanced
Setup Workflow” on page 92).

Notes
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About Presence/Absence Experiments

About the PCR  With presence/absence experiments, you prepare PCR reactions that contain primers and
Reactions probes to amplify the target and a reagent to detect amplification of the target. You can set up
the PCR reactions for the presence/absence experiments three different ways:

IPC setup — Use an internal positive control (IPC) to monitor the PCR progress and ensure
that a negative result is not caused by failed PCR in the sample. PCR reactions contain two
primer/probe sets: One to detect the unknown target (unknown target primer set and TagMan
probe to detect the unknown target) and one to detect the IPC (IPC primer set and a VIC dye-
labeled TagMan probe to detect the IPC template). With this setup, there are three well types:

*  Unknown-IPC wells — Wells contain sample template and IPC template; the presence
of the target is not known.

* Negative control-IPC wells — Wells contain IPC template and water or buffer instead of
sample template in the PCR reaction. Only the IPC template should amplify in negative
control-IPC wells because the reaction contains no sample template. Also called /PC+.

* Negative control-blocked IPC wells — Wells contain IPC blocking agent instead of
sample template in the PCR reaction. No amplification should occur in negative
control-blocked IPC wells because the reaction contains no sample template and
amplification of the IPC is blocked. Also called no amplification control (NAC).

No IPC, singleplex setup — Use Advanced Setup to omit the IPC from your
presence/absence experiment. PCR reactions contain one primer/probe set. PCR reactions do
not contain the IPC. With this setup, there are two well types:

* Unknown wells — Wells contain sample template; the presence of the target is not
known.

* Negative controls —Wells contain water or buffer instead of sample template.

No IPC, multiplex setup — Use Advanced Setup to omit the [PC from your
presence/absence experiment and detect two targets in one reaction. PCR reactions contain
two primer/probe sets. PCR reactions do not include the IPC. With this setup, there are two
well types:

* Unknown-Unknown wells — Wells contain sample template; the presence of the target
is not known.

* Negative control-Negative control wells — Wells contain water or buffer instead of
sample template.

About the With presence/absence experiments, the instrument runs can include:
Instrument Run * Pre-PCR read — Perform the pre-PCR read on the 7500/7500 Fast instrument
before PCR amplification to collect baseline fluorescence data.

* Amplification — Perform amplification on the 7500/7500 Fast instrument. If you do
not include amplification in the run method, you need to perform amplification on
another instrument.

* Post-PCR read — The post-PCR read is required to determine the results for
presence/absence experiments. Perform the post-PCR read on the instrument after
PCR amplification to collect endpoint fluorescence data.

Fluorescence data collected during the instrument run are stored in an experiment data
file (EDS).

Notes
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About Presence/Absence Experiments

About the Data from the instrument run are used to determine presence/absence calls. Results are
Analysis plotted in a presence/absence plot. If the experiment includes amplification, results are
plotted in an amplification plot.

Pre-PCR read — If included, the data collected from the pre-PCR read can be used to
normalize data collected from the post-PCR read.

Amplification — If included, the data collected from the amplification can be used to
troubleshoot.

Post-PCR read — The data collected from the post-PCR read are used to make
presence/absence calls:

* Presence — The target amplified above the target’s threshold. The target is present
in the sample.

» Absence — The target did not amplify above the target’s threshold. The target is
absent in the sample.

* Unconfirmed — The target exhibited amplification but was below the target
threshold. The target cannot be confirmed and the sample must be retested.

With the IPC setup, the data collected form the post-PCR read are used to make the
following calls:

* IPC Failed — The IPC target did not amplify in the IPC wells and/or the IPC target
amplified in the blocked IPC wells.

* IPC Succeeded — The IPC target amplified in the IPC wells and the IPC target did
not amplify in the blocked IPC wells.

Notes
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How to Use This Guide

This guide functions as both a tutorial and as a guide for performing your own
experiments.

Using This Guide Using example experiment data provided with the 7500 software, you can use this guide
as a Tutorial as a tutorial for performing a presence/absence experiment on a 7500/7500 Fast system.
Follow the procedures in chapters 2 through 5:

Chapter Procedure
2 Design the experiment using the Design Wizard in the 7500 software.
3 Prepare the experiment, using the reagents and volumes calculated by the

Design Wizard in Chapter 2.

4 Run the experiment on a 7500/7500 Fast instrument.

5 Analyze the results.

For more information, see “About the Example Presence/Absence Experiment” on
page 12.

Using This Guide After completing the tutorial exercises in Chapter 2 through 5, use this guide to lead you
with Your Own through your own presence/absence experiments. Each procedure in Chapters 2 through
Experiments 5 includes a set of guidelines that you can use to perform your own experiments.

Additionally, you can use one of the other workflows provided in the 7500 software to
perform your experiments. The table below provides a summary of all the workflows
available in the 7500 software.

Workflow Description See...

Design Wizard | Set up a new experiment with guidance from the software. | Chapter 2
The Design Wizard guides you through best practices as
you create your own experiment. The Design Wizard is
recommended for new users.

Note: Design options are more limited in the Design
Wizard than in Advanced Setup.

Advanced Set up a new experiment using advanced options. page 92
Setup Advanced Setup allows design flexibility as you create
your own experiment. Advanced Setup is recommended
for experienced users.

QuickStart Run a new experiment with no plate setup information. If page 93
desired, you can add all design parameters after the run.

Template Set up a new experiment using setup information from a page 95
template.

Export/Import Import experiment designs from ASCII text files that page 96

contain experiment setup information.

Notes
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About the Example Presence/Absence Experiment

To illustrate how to perform presence/absence experiments, this guide leads you through
the process of designing, preparing, running and analyzing an example experiment. The
example experiment represents a typical setup that you can use to quickly familiarize
yourself with a 7500/7500 Fast system.
Description  The objective of the presence/absence example experiment is to determine if a pathogen
is present in each batch of ground beef.

In the presence/absence example experiment:

+ DNA is extracted from samples using the PrepMan® Ultra Sample Preparation
Reagent. The DNA is extracted from bacteria found in five samples of ground beef.

* The target is a pathogen.

» The experiment is designed for duplex PCR, where each reaction contains two
primer/probe sets. One set detects the unknown target (primer set and FAM™
dye-labeled probe to amplify and detect the target sequence). The other
primer/probe set detects the IPC primer set and VIC® dye-labeled TagMan probe
amplifies and detects the IPC template.

Reaction Plate The 7500 software displays the 96-well reaction plate layout as shown below:

Layout
1 2 3 4 i B 7 g 9 10 11 12
= g Eample 1 Eample 2 Eample 3 Sample 4 Eample 5 Eample B Eample 7 Eample B Sample Sample 10
IPC IPC IPC IPC IPC IPC IPC IPC IPC IPC
A
] Fsthoae=n g7 Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen
PC c PC Sample 1 Sample 2 Sample 3 Sample 4 Sample 5 Sample & Sample 7 Sample 8 Sample @ Sample 10
IPC IPC IPC IPC IPC IPC IPC IPC IPC IPC
E
] Fsthoae=n g7 Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen
PC c PC Sample 1 Sample 2 Sample 3 Sample 4 Sample 5 Sample & Sample 7 Sample 8 Sample @ Sample 10
IPC IPC IPC IPC IPC IPC IPC IPC IPC IPC
c
] Fsthoae=n g7 Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen
PC c PC Sample 1 Sample 2 Sample 3 Sample 4 Sample 5 Sample & Sample 7 Sample 8 Sample @ Sample 10
IPC IPC IPC IPC IPC IPC IPC IPC IPC IPC
8]
] Fsthoae=n g7 Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen
PC c PC Sample 1 Sample 2 Sample 3 Sample 4 Sample 5 Sample & Sample 7 Sample 8 Sample @ Sample 10
IPC IPC IPC IPC IPC IPC IPC IPC IPC IPC
E
] Fsthoae=n g7 Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen
PC c PC Sample 1 Sample 2 Sample 3 Sample 4 Sample 5 Sample & Sample 7 Sample 8 Sample @ Sample 10
IPC IPC IPC IPC IPC IPC IPC IPC IPC IPC
F
] Fsthoae=n g7 Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen
PC c PC Sample 1 Sample 2 Sample 3 Sample 4 Sample 5 Sample & Sample 7 Sample 8 Sample @ Sample 10
IPC IPC IPC IPC IPC IPC IPC IPC IPC IPC
G
] Fsthoae=n g7 Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen
PC c PC Sample 1 Sample 2 Sample 3 Sample 4 Sample 5 Sample & Sample 7 Sample 8 Sample @ Sample 10
IPC IPC IPC IPC IPC IPC IPC IPC IPC IPC
H [ Pathegen | [] Patnoaen
Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen Pathogen
Wells: 0 Unknown 0 MNC | 80 Unknown-IPC 8 MC-IPC 8 NC-Blocked IPC 0 Empty

Notes
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About the Example Presence/Absence Experiment

About the In this getting started guide, you will use two files:

. Example » In Chapter 2, you will create a presence/absence example experiment that contains
Experiment Data setup data, then you will save the file to your computer.

» In Chapter 5, you will view results in a presence/absence example experiment file
that contains run data. The data file for the example experiment installs with the
7500 software. You can find the data file for the example experiment on your
computer:

<drive>\Applied Biosystems\<software name>\experiments\

Presence Absence Example.eds

where:

— <drive> is the computer hard drive on which the 7500 software is installed.
— <software name> is the current version of the 7500 software.

Example Files in the Experiments Folder

The experiments folder of the 7500 software contains several example files that you can
reference when analyzing your own data. The following example files install with the
7500 software:

» Comparative Ct Example.eds

* Comparative Ct Study Example.edm

* Comparative Ct Study (Biological Groups).edm
* Genotyping Example.eds

* Presence Absence Example.eds

» Relative Standard Curve Example.eds

» Standard Curve Example.eds

Note: Be sure to use the Presence Absence Example.eds file when you perform the
procedures in this guide.

Notes

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence 13
Experiments



n Chapter 1 Get Started

Example Experiment Workflow

Example Experiment Workflow

The figure below shows the workflow for the presence/absence example experiment.

Design the Experiment (Chapter 2)
. Create a new experiment.
. Define the experiment properties.
. Define the methods and materials.
Set up the targets.
Set up the samples.
Set up the run method.
Set up the reactions.
Order materials for the experiment.

© ©® N O O s N 2

Finish the Design Wizard.

Prepare the Reactions (Chapter 3)
Prepare the template.
Prepare the samples.
Prepare the reaction mix.

> w b=

Prepare the reactions.

Run the Experiment (Chapter 4)
Prepare for the run.
Enable the notification settings (Optional).
Start the run.
Monitor the run.

o~ wnh =

Unload the instrument and transfer the data.

Analyze the Experiment (Chapter 5)
Section 1, Review Results:
. Analyze the experiment.
. View the presence/absence plot.
. View the ampilification plot.
. View the results in a table.
. Publish the data
Section 2, Troubleshoot (If Needed):

6. View the analysis settings.

O A WO N =

7. View the quality summary.
8. Omit wells.
9. View the multicomponent plot.

10.View the raw data plot.

Notes
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Chapter 2

Design the Experiment

This chapter covers:

Chapter OVeIVIEW . . o\ttt e e e e e e 16
Create a New EXperiment. . .. ...t 17
Define the Experiment Properties . .............. .. ..., 18
Define the Methods and Materials ... .......... ... ... ... ... ... ........ 20
Set Upthe Targets. . ... ..ottt e e e e e 22
Set Up the Samples and Replicates. . ............. ... ... . i .. 23
Set Upthe RunMethod ....... ... ... . .. . .. 25
Review the Reaction Setup. . ........ ... i 27
Order Materials for the Experiment .. ............... .. .. .. .. ........... 31
Finish the Design Wizard . .. ...... ... ... ... . . i 33

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.
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Chapter Overview

Chapter Overview

This chapter explains how to use the Design Wizard in the 7500 software to set up the
presence/absence example experiment. The Design Wizard guides you through Applied
Biosystems recommended best practices as you enter design parameters for the example
experiment.

Note: When you design your own experiments, you can select alternate workflows (see
“Using This Guide with Your Own Experiments” on page 11).

Example
Experiment

Workflow v
Design the Experiment (Chapter 2)

Start Experiment

Create a new experiment.

Define the experiment properties.
Define the methods and materials.
Set up the targets.

Set up the samples.

Set up the run method.

Review the reaction setup.

Order materials for the experiment.

© ® N ok~ Db

Finish the Design Wizard.

<

Prepare the Reactions (Chapter 3)

|

Run the Experiment (Chapter 4)

<

Analyze the Experiment (Chapter 5)
v

End Experiment

Notes

16 Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence
Experiments



Chapter 2 Design the Experiment n

Create a New Experiment

Create a New Experiment

Create a new experiment using the Design Wizard in the 7500 software.

Create an 1. Double-click (7500 software) or select Start » All Programs » Applied
Experiment Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.

2. In the Home screen, click Design Wizard to open the Design Wizard.

Notes
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Define the Experiment Properties

Define the Experiment Properties

In the Experiment Properties screen, enter identifying information for the experiment,
select the instrument type, then select the type of experiment to design.

About the In the presence/absence example experiment:

Example * The experiment is identified as an example.

Experimen . . . .
periment » The instrument selected to run the experiment is the 7500 instrument.

+ A MicroAmp® Optical 96-Well Reaction Plate is used.
» The experiment type is presence/absence.

Complete the 1. Click the Experiment Name field, then enter Presence Absence Example.

Experiment
Properties Screen Note: The experiment header updates with the experiment name you entered.

2. Leave the Barcode field empty.
3. Click the User Name field, then enter Example User.

4. Click the Comments field, then enter Presence Absence Getting Started Guide
Example.

5. Select 7500 (96 Wells).
6. Seclect Presence/Absence for the experiment type.

7. Click Next.

1A. Define: Experiment Properties Experiment Properties Help 9}

u Instructions: Enter an experiment name, selectthe instrumeant type, then select the type of experimentto design.

How do you want to identify this experiment? = Required
1 ‘ “EXPENITIENL NETTE. | Presence Absence Example ‘
2 Barcoue (OpionE) | |
3 T pophuiE | Example User
4

—ﬁrresence Absence Getting Startad Guide Example S
v

5 Which instrument are you using to run the experiment?

[ 7 7500 (ES‘WeHs} ] [ 7500 Fast (36 Wells) ] _

Setup, run, and analyze an experiment using a 4- or 5-color, 96-well systemn

What type of experiment do you want to design?

[ Guantitation ] [ Genatyping ] { + Presence / Absence }
6 Design a presencefabsence experiment to determine whether a target nucleic acid sequence is presentor absentin 3 sample.
L
Notes
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Define the Experiment Properties

Design  When you design your own presence/absence experiment:

Guidelines » Enter an experiment name that is descriptive and easy to remember. You can enter
up to 100 characters in the Experiment Name field. You cannot use the following
characters in the Experiment Name field: /\><*?"|:;

Note: The experiment name is used as the default file name.

* (Optional) Enter a barcode to identify the barcode on the reaction plate. You can
enter up to 100 characters in the Barcode field.

* (Optional) Enter a user name to identify the owner of the experiment. You can enter
up to 100 characters in the User Name field.

* (Optional) Enter comments to describe the experiment. You can enter up to
1000 characters in the Comments field.

* Select the instrument you are using to run the experiment:
— 7500 (96 Wells)
— 7500 Fast (96 Wells)

Note: You can use 7500 software design experiments for the 7500/7500 Fast
instrument. The instrument you select in the Experiment Properties screen affects
the reaction plate layout and materials list.

Note: To set the default instrument type, select Tools » Preferences, then select the
Defaults tab (default). In the Default Instrument Type drop-down list, select the
appropriate instrument.

®! proferances 3]
_Dafaulls ||

[t B3

nler 3 o
salect e

Sampes Reacsion Val.: | 50 e

Data Foldin C\hppsiad Blosystemsl? S00esperimants rin

mpart Falder C\4ppiad Biosystamsl7 S00isxparimanis
et Fosdier CAppNad Dlosystemel SO0Exparimants

pnstnarman Type. 7500 el

» Select Presence/Absence as the experiment type.

For More For more information on:

Information * Completing the Experiment Properties screen — Access the 7500 Software Help by
clicking @ or pressing F1.
* Consumables — See “Order Materials for the Experiment” on page 31.

» Presence/absence experiments — Refer to the Applied Biosystems Real-Time PCR
Systems Reagent Guide.

Notes
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Define the Methods and Materials

Define the Methods and Materials

In the Methods & Materials screen, view the reagents, DNA template and ramp speed to
use for the experiment.

About the In the presence/absence example experiment:

E Exa_lmplci + TagMan® reagents are used.
Xperimen . . .
perime * The standard ramp speed is used in the instrument run.

* DNA template is the type of nucleic acid sample added to the PCR reactions.
Complete the 1. Make sure TagMan® Reagents is displayed for the reagents.

Methods &

Materials Screen . Make sure DNA is displayed for the template type.

2
3. Make sure Standard (~2 hours to complete a run) is displayed for the ramp speed.
4. Make sure Pre-PCR Read and Amplification are selected for the stages.

5

. Click Next.

1B. Define: Methods & Matenals Methods & Materials Help @

u Instructions: Review the reagents and type of template to use for this presencel/absence experiment, then select the stages for the instrument run

Use TagMan® reagents in the PCR reactions for this presence/absence experiment.

1 - ¥ TagMan® Reagents
I il g

The PCR reactions contain a forward primer, a reverse primer, and a TagMan probe. The primers ars designed to amplify the targst sequence. The TagMan probe is designed to
hybridize to the target sequence and gensrate luorescence signal when the target sequence is amplified

Use a DNA template in the PCR reactions for this presence/absence experiment.

2 —7[  DNA ]

Use an optimized protocol to extract the DMA. Then, make sure the A260/280 ratio is greater than 1.7, agarose gel electrophoresis shows the DMA is intact, and the DNA has notbeen
heated above 60 °C

Use the standard ramp speed for this presence/absence experiment.

3 77[./ Standard (~ 2 hours to complete a run)}

For optimal results using the standard ramp speed, Applied Biosystems recommends standard reagents for your PCR reactions.

Which stages do you want to include in the instrument run?

4 —[¥] Pre-PCR Read ‘Mﬂmpliﬂcalion Post-PCR Read

Notes
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Define the Methods and Materials

Design  When you design your own presence/absence experiment:

Guidelines + TagMan® reagents use a TagMan® probe to detect amplification of the target. In the
presence/absence experiments, TagMan reagents consist of two primer/probe sets.
The primers are designed to amplify the target and the IPC template. The TagMan
probes are designed to hybridize to the target and the IPC and generate fluorescence
when the target and IPC are amplified.

Note: Applied Biosystems recommends that you use TagMan reagents for
presence/absence experiments. If you want to use other reagents, use Advanced
Setup (see “Advanced Setup Workflow” on page 92) to set up your experiment.

» DNA template is used in the presence/absence experiment.

» Select the Standard ramp speed for the instrument run.

IMPORTANT! The Design Wizard does not support Fast ramp speeds for
presence/absence experiments. If you want to use Fast ramp speeds, use Advanced
Setup to set up your experiment.

» Select the appropriate stages for the instrument run:

— Pre-PCR Read — If you do not want to collect data before amplification, deselect
the Pre-PCR Read check box.

Note: Applied Biosystems recommends that you include the pre-PCR read in
the 7500/7500 Fast instrument run.

— Amplification — If you want to perform amplification on a thermal cycler,
deselect the Amplification check box.

Note: Applied Biosystems recommends that you include the amplification
stage in the 7500/7500 Fast instrument run. You can use the data collected
during amplification to troubleshoot.

— Post-PCR Read — This required stage is preselected for you.

For More For more information on:

Information » Completing the Methods & Materials screen — Access the 7500 Software Help by
clicking @ or pressing F1.

» TagMan reagents — Refer to the Applied Biosystems Real-Time PCR Systems
Reagent Guide.

» Using Advanced Setup — See “Advanced Setup Workflow” on page 92.

* PCR, including singleplex vs. multiplex PCR — Refer to the Applied Biosystems
Real-Time PCR Systems Reagent Guide.

Notes
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Set Up the Targets

Set Up the Targets

About the
Example
Experiment

Complete the
Targets Screen

2A. Set Up: Targets

In the Targets screen, enter the name of the target that you want to detect in the PCR
reaction plate (Unknown), then enter the name of the internal positive control (IPC)
target.

In the presence/absence example experiment:

* A pathogen is used as the unknown target and an IPC is used as the IPC target. The
IPC target ensures that a negative result is not the result of a failed PCR reaction.

» Each well in the reaction plate contains an IPC.

1. Click the What is the name of the target you want to detect (Unknown)? field,
then enter Pathogen.

2. Click the What is the name of the IPC target? field, then enter IPC.

Note: The Targets Used in Experiment table updates with the target names.

3. Leave the default colors in the Color drop-down lists.

4. Click Next.

Targets Help @

a Instructions: Enterthe name of the target to detect in the reaction plate (Unknown), then enter the name of the internal positive control (IPC) target.

Set Up: Targets

+Whatis the name ofthe target you want to detect (Unknown)? The unknown target is detected using FAM 'Pathugen | Enter Unknown laig=i riaries 1
+What is the name of the IPC target? The IPC target is detected using VIC reporter dye. | IPC | Enter 1PC target name
Targets Used in Experiment 2
‘V Task ) I Target Name T Reporter Quencher T Color
UNKNOWN Pathogen FAmMm NFO-MGE v 3
IPC IPC wIC NFO-MGBE v
Design  When you design your own presence/absence experiment, identify the target and the IPC
Guidelines  with a unique name and color. You can enter up to 100 characters each for the unknown
target name and the IPC target name.
Note: In the Design Wizard, the unknown target is detected using a FAM™ dye-labeled
TagMan probe and the IPC target is detected using a VIC® dye-labeled TagMan probe.
Note: If you want to set up your presence/absence experiments without the [PC, perform
advanced setup. See “Advanced Setup Workflow” on page 92.
For More For more information on completing the Targets screen, access the 7500 Software Help
information by clicking @ or pressing F1.
Notes
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Set Up the Samples and Replicates

Set Up the Samples and Replicates

In the Samples & Replicates screen, enter the number of samples, replicates, and negative
controls to include in the reaction plate, enter the sample names, then select which
sample/target reactions to set up.

About the In the presence/absence example experiment:

Example » Ten samples are used, where the presence/absence of the target (a pathogen) is unknown.

Experiment + Eight Unknown-IPC replicates are used. Replicates are identical to the sample reactions,

containing identical components and volumes.

+ Eight Negative Control-Blocked IPC replicates are used. Replicates contain [PC
template and IPC blocking agent instead of sample template.

+ Eight Negative Control-IPC replicates are used. Replicates contain IPC template and
buffer or water instead of sample template.

Complete the 1. Click the How many samples do you want to test in the reaction plate? ficld,
Samples & then enter 10.

Replicates .
Screen 2. In the Enter Sample Name fields, enter:

e Unknown 1
e Unknown 2
e Unknown 3
e Unknown 4
e Unknown 5
e Unknown 6
e Unknown 7
e Unknown 8
e Unknown 9
e Unknown 10

3. Leave the default colors in the Color drop-down lists.

4. Click the How many replicates do you need for reactions that contain sample?
(Unknown-IPC wells) field, then enter 8.

5. Click the How many replicates do you need for reactions that contain IPC blocking
agent instead of sample? (Negative Control-Blocked IPC wells) field, then enter 8.

6. Click the How many replicates do you need for reactions that contain water or
buffer instead of sample? (Negative Control-IPC wells) field, then enter 8.

7. Inthe Well Count pane, confirm that there are:
e 80 Unknown-IPC [0
8 Negative Control-Blocked IPC &
8 Negative Control-IPC [

Notes
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Set Up the Samples and Replicates

8. In the View Plate Layout pane:
a. In the Arrange Plate by drop-down list, select Columns.

b. In the Place Negative Controls in drop-down list, select Upper Left.

9. Click Next.

2B. Set Up: Samples & Replicates Samples & Replicates Help g,

G Instructions: Enter the number of samples to testin the reaction plate, enter sample names, then enter the number of replicates for each type of reaction

Set Up: Samples & Replicates - : View Plate Layout

8a
1 * How many samples do youwant to testin the reaction plate? | 10 Arrange Plate by: Columns Place MNegative Caontrols in: UpperLeft
For each sample in the reaction plate, enter a sample name and select a samg/le color. = 8b
* Enter Sample Name Colar | @ ShowinWells ¥ View Legend ‘ | E |
2 Unknown 1 | v |2 1 [ 2 [ 3 [ 4[5 [ e[ 7 [e [ g [0 [12]
[Unknown 2 | v NiEEEE v @@ v dloidio
nknown 3 | v [
‘Unknuwnat | 3 B gF‘.EF’.mF mP.mF’.F’ mP.mF’.mF’ P.mF’. VU
‘Unknuwnﬁ | v [ - - - - ==
P [ Ll 1 o i o o Bl Bl o Bl o i o Bl o s
[Unknown 6 | il BER A e e e e e e e = =
\Unknown? | 4 ;np U o Tl o o Mt Tl o Mgt 1 o Bt T o Bl o 13
4 [ inkenan | b _m“——————————
E—LIJ?qwknn;ir;\!‘rPegl‘l‘:zﬁass) do you need for reactions that contain sampla? I—‘——Sl : g P E - P mr P | m" P »m" P
How many replicates do you need for reactions that contain IPC blocking Ij' —
6 agent instead of sample? (Negative Control-Blocked IPC wells) ¢ M | me P " me P *me P *me P
How many replicates do you need for reactions that contain water or Ijl B Ml e o= (= (o= (e (= e (e (e e
huffer instead of sample? (Megative Control-IPC wells) 1
P o 1 o o o Bl o Bl Bl o Bl o o Bl o s
- Bl em |[om (o (om (om (om (em (mm (e e
7 80 - Unknown-IPC 8 - Negative Contro-Blocked IPC 8 - Negative Control-IPC H g 3 E a0 R0 Rt o B R Rl o ' R Bl 1 Bl L)
< ] B = e
Design  When you design your own presence/absence experiment:
Guidelines * Identify each sample with a unique name and color. You can enter up to
100 characters in the Sample Name field.
* Enter the number of Unknown-IPC replicates to set up. Applied Biosystems
recommends 3 Unknown-IPC replicates.
* Enter the number of Negative Control-Blocked IPC replicates to set up. Applied
Biosystems recommends 3 Negative Control-Blocked IPC replicates.
* Enter the number of Negative Control-IPC replicates to set up. Applied Biosystems
recommends 3 Negative Control-IPC replicates.
* [f the number of reactions required exceeds the number of wells in the reaction
plate, reduce the number of samples, Unknown-IPC replicates, Negative Control-
Blocked IPC replicates, and/or Negative Control-IPC replicates.
For More For more information on completing the Samples & Replicates screen, access the 7500
Information Software Help by clicking @ or pressing F1.
Notes
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Set Up the Run Method

Set Up the Run Method

In the Run Method screen, review the reaction volume and the thermal profile for the
default run method. If needed, you can edit the default run method, or replace it with one
from the library.

About the In the presence/absence example experiment, the default run method is used without
Example edits.
Experiment

Review the Run 1. Click either the Graphical View tab (default) or Tabular View tab.

Method Screen , .
Click the Reaction Volume Per Well field, then enter 25 pL.

Make sure the Pre-PCR Read and Amplification check boxes are selected.

Make sure the thermal profile displays the holding and cycling stages shown below.

o & @ Db

Click Next.

2C. Set Up: Run Method Run Method Help g

a Instructions; 2V1EW the reaction volume and the default thermal profile for the stages you selzcted for the instrument run. If needed, change your selection, editthe run method, or
1 : " replace the run method with one from the library.

Graphical ViewT Tabular View l

2 |
Reaction Volume Per Well 25.0 | uL [ Expert Mode
Add stage v | Addstep v | 1] collectpat v [ open Run wethod | save Run method . | Revertto Detauts | |
[ I - 3
4 Include: [¥] Pre-PCR Read [#] Amplification
| |
Pre-PCR Read (Holding Stage) Holding Stage Cycling Stage IFosl—PCR Read (Holding Stage). -
Number of Cycles
[] Enable AutaDelta
Starting Cycle
100 —| 95.0°C 95.0°C
10:00 100% 00:15
7 T00% i
60.0°C 60.0°C 60.0°C
e ———
50 —| 01:00 01:00 100% 01:00
o
28 —| -
bt
@ >
Legend
Data Collzction On Data Collsction Off A AutoDelta On A AutoDelta Off ‘
G Mote: Setthe temperatures for the pre-PCR read and post-PCR read to the same value for accurate analysis.
Notes
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Set Up the Run Method

Design  When you design your own presence/absence experiment:

Guidelines » Enter a reaction volume/well. Applied Biosystems recommends a reaction volume
of 25 uL for presence/absence experiments. The 7500 system supports reaction
volumes from 20 to 100 puL. The 7500 Fast system supports reaction volumes from
10 to 30 pL.

* Review the thermal profile to make sure that it is appropriate for your reagents.

If your experiment requires a different thermal profile, edit the thermal profile or
replace the run method with one from the Run Method library. The Run Method
library is included in the 7500 software.

For More For more information on:

Information * The run method library or completing the Run Method screen — Access the 7500
Software Help by clicking @ or pressing F1.

» Using Advanced Setup — See “Advanced Setup Workflow” on page 92.

Notes
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Review the Reaction Setup

Review the Reaction Setup

In the Reaction Setup screen, select the assay type, then review the calculated volumes
for preparing the samples, controls, and PCR reactions.

IMPORTANT! Perform these steps for each target in the reaction plate.

About the In the presence/absence example experiment:

Exa_lmple » The assay type is Inventoried/Made to Order
Experiment * The reaction volume per well is 25 pL with a 10% excess.
* The reaction components are:

— TagMan® Universal PCR Master Mix (2.0X)
IPC Mix (10X)
IPC DNA (50X)
Primer/Probe Mix (20.0X)
— Water

* For all samples:

— The stock concentration of sample DNA is 100.0 ng/uL.
— The sample DNA is diluted to a concentration of 50.0 ng/uL.

— The diluted sample DNA (50.0 ng/uL) is at a 10X concentration: 2.5 pL is used to
prepare a 25-uL reaction.

— The final concentration of sample DNA in the reactions is 5.0 ng/uL.

Complete the Complete the Reaction Mix Calculations Tab

Reaction Setup

Screen 1. Select the Reaction Mix Calculations tab (default).

Make sure the Assay Type field displays Inventoried/Made to Order.
Make sure the Reaction Volume Per Well field displays 25 uL.

Make sure the Excess Reaction Volume field displays 10%.

o > @D

In the Reaction Mix pane:
a. Make sure the Master Mix Concentration field displays 2.0X.
b. Make sure the Primer/Probe Mix Concentration field displays 20.0X.

Notes

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence 27
Experiments



Chapter 2 Design the Experiment

Review the Reaction Setup

c. Review the components and calculated volumes for the PCR reactions:

Component  Velume ) for - Volume (4 for 9 Rezctons
| Master Mix (2.0X) 12.50 1320.00
10X IPC Mix 2.50 264.00
50X IPC DNA 0.50 52.80
Primer/Probe Mix (20.0X) 1.25 132.00
Water 5.75 607.20
| Total Volume 22.50 2376.00
2 3 4

2D. Set Up: Reaction Setup Reaction Setup Help 9/

areparing the PCR reactions. If nesded, edit
15 on how to prepars the PCR reactions.

u Instructions; Selectthe assaytypp, then review the calculated volumes for the reaction volume, excess samples, and/or component

concentrations. Clic;"Print Reaction Setup” to print instructio

Assay Type |Inventoried/Made to Order |+ Reaction Wolume Per Well [/ Excess Reaction Volume % | Print Reaction Setup

1 "Reaction Mix Calculations Sarnple Dilution Calculations
Reaction Mix
5a ‘
Master Mix Concentration: 20X Primer/Probe Mix Concentration: 200 | X
5b ‘
Component Final Concentration Volume (uL) for 1 Reaction Volume (uL) for 96 Reactions
1 12.50 1,320.00
50-900 nM 2.50 264.00
50 — 50-900 nM 0.50 52.80
50-250 nM 1.25 132.00
Water - 575 607.20
Total - 2250 2,376.00
‘Well Type Component Wolume (pL) for 1 Reaction # of Wells Total Volume (pL) Added Per W.
Megative Control-Blocked IPC 10 IPC Block 2.5 g 220 55
Megative Control-IPC 14 TE ar Water 2.5 8 220 =
Unknown 1 Sample DMA (10X} 2.5 g 220
6. In the Control & Sample Volume pane, review the calculated volumes for preparing
the reactions:
Volume (pL) for Total Volume (pL)
Well T mponent . # of Well
ell Type Compone 1 Reaction ot Wells Added per Well Type
Negative Control-Blocked IPC 10X IPC Block 2.5 8 22.0
Negative Control-IPC 1X TE or Water 25 8 22.0
Unknown 1 Sample DNA (10X) 25 8 22.0
Unknown...10 8 22.0

Notes

Sample DNA (10X) 25

28
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Review the Reaction Setup

Complete the Sample Dilution Calculations Tab

-
.

Select the Sample Dilution Calculations tab.

2. Click the Diluted Sample Concentration (10X for Reaction Mix) field, then enter 50.0.
3. In the unit drop-down list, select ng/uL (default).
4

Review the calculated volumes for the sample dilutions:

Sample Name Stock ((::E;zir;tration Sampl(: I\-I)olume Diluer;:l \Ll)olume Total Volume ?;Biluted Sample
Unknown 1 100.0 11.00 11.00 22.00
Unknown 2 100.0 11.00 11.00 22.00
Unknown 3 100.0 11.00 11.00 22.00
Unknown 4 100.0 11.00 11.00 22.00
Unknown 5 100.0 11.00 11.00 22.00
Unknown 6 100.0 11.00 11.00 22.00
Unknown 7 100.0 11.00 11.00 22.00
Unknown 8 100.0 11.00 11.00 22.00
Unknown 9 100.0 11.00 11.00 22.00
Unknown 10 100.0 11.00 11.00 22.00

2D. Set Up: Reaction Setup Reaction Setup Help @)

a Instructions; S12¢tthe assay ype, then review the calculated volumes for preparing the PCR reactions. If nesded, edit the reaction volume, excess samples, and/or component
" concentrations. Click"Print Reaction Setup” ta print instructions on how to prepare the PCR reactions.

y Assay Type |InventoriediMads to Order v|  Reaction Volume PerWell: | 25| uL  Excess Reaction Volume: | 10| % [ Print Reaction Setup
2 Reaction Mix Calculations T Sample DiIutiol\ Calculations ]
3 Diluted Sample Concentration (10X for Reaction Wiy, | 500 | [ngiuL %
Sample Name Stock Concentration (ng/uL) Sample Volume (uL) Diluent Volume (uL) Total Volume of Diluted Sample (UL)
Unknown 1 [ 100.0 | 11.00 11.00 22.00
Unknown 2 [ 100.0 | 11.00 11.00 22.00
Unknown 3 [ 100.0 | 11.00 11.00 22.00
Unknown 4 [ 100.0 | 11.00 11.00 22.00
Unknown § [ 100.0 | 11.00 11.00 22.00
4 — Unknown & [ 100.0 | 11.00 11.00 22.00
Unknown 7 [ 100.0 | 11.00 11.00 22.00
Unknown & [ 100.0 | 11.00 11.00 22.00
Unknown 9 [ 100.0 | 11.00 11.00 22.00
Unknown 10 [ 100.0 | 11.00 11.00 22.00
Notes
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Print Reaction Setup Instructions

Print detailed reaction setup instructions, then save the instructions for Chapter 3.

1. Click Print Reaction Setup.

Reaction Setup Help 0/

the PCR reactions. If needed, editthe reaction volume, excess samples, andfor compaonent
to prepare the PCR reactions

Excess Reaction Volume: 10 | % | Print Reaction Setup | 1
2. In the dialog box, select:

* Detailed Reaction Setup Instructions

* Include Plate Layout

e Use sample color

3. Click Print to print the reaction setup instructions.

Print Reaction Setup g]
a Select the type of instructions to print

© summary Reaction Setup Instructions
T (#) Detailed Reaction Setup Instructions

include Plate Layout

N

‘ Select Plate Layout Color
(= Use sample color
(O Use task color

Preview ‘ | Print | | cancel

4. Click Next.

Design  When you design your own presence/absence experiment:
Guidelines * Select the type of assay you are using:

— Inventoried/Made to Order — The primers and TagMan probe are provided
together in one ready-to-use assay mix.
— Custom — The primers and TagMan probe are designed and provided separately.
» Enter a reaction volume/well. Applied Biosystems recommends a reaction volume
of 25 uL for presence/absence experiments. The 7500 system supports reaction

volumes from 20 to 100 uL. The 7500 Fast system supports reaction volumes from
10 to 30 uL.

* Include excess reaction volume to account for the loss that occurs during pipetting.
Applied Biosystems recommends an excess reaction volume of at least 10%.

* Review the components and calculated volumes for the PCR reactions. If needed,
edit the master mix and primer/probe mix concentrations.

For More For more information on completing the Reaction Setup screen, access the 7500
Information  Software Help by clicking @ or pressing F1.

Notes
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Order Materials for the Experiment

Order Materials for the Experiment

In the Materials List screen, review the list of materials recommended to prepare the PCR
reaction plate. (Optional) Print the materials list, create a shopping list, then order the
recommended materials from the Applied Biosystems Store.

Note: To access the Applied Biosystems Store, you need to have an Internet connection.
Product availability and pricing may vary according to your region or country. Online
ordering through the Applied Biosystems Store is not available in all countries. Contact
your local Applied Biosystems representative for help.

Note: The 7500 software recommends the materials to order based on your experiment
design. It is assumed that you will design your experiment, order your materials, then
prepare (Chapter 3) and run (Chapter 4) the reaction plate when your materials arrive.

About the In the presence/absence example experiment, the recommended materials are:
Exa_lmple + MicroAmp® Optical 96-Well Reaction Plate
Experiment * MicroAmp"" Optical Adhesive Film
+ MicroAmp® Splash Free Support Base
+ TagMan® Universal PCR Master Mix (2X)

Complete the 1. In the Display drop-down list, select All Items (default), then review the

Experiment recommended materials. If needed, use the scroll bar at right to see all items.
Materials List
Screen Note: For more information on a specific item, click the part number link. You will

be connected to the product information page in the Applied Biosystems Store. To
access the Applied Biosystems Store, you need to have an Internet connection.

2. (Optional) Click Print Materials List to print the materials list.

3. (Optional) Create a shopping list:

a. Select the check box next to each of the following items:
+ MicroAmp® Optical 96-Well Reaction Plate
+ MicroAmp"" Optical Adhesive Film
+ MicroAmp® Splash Free Support Base
+ TagMan® Universal PCR Master Mix (2X)

b. Click Add Selected Items to Shopping List.

Notes
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Order Materials for the Experiment

4. (Optional) Create a shopping basket in the Applied Biosystems Store:

Note: To access the Applied Biosystems Store, you need to have an Internet
connection. Product availability and pricing may vary according to your region or
country. Online ordering through the Applied Biosystems Store is not available in all
countries. Contact your local Applied Biosystems representative for help.

a. Check that the Experiment Shopping List contains the desired materials and
that the quantities are correct, then click Order Materials in List.

b. In the Order Materials - Log In dialog box, enter your user name and password
for the Applied Biosystems Store, then click Log In and Submit.

Note: If you do not have an account with the Applied Biosystems Store, click
Register Now to create an account.

c. When you are connected to the Applied Biosystems Store, follow the prompts
to complete your order.

5. Go to “Finish the Design Wizard” on page 33.

Design  When you design your own presence/absence experiment:
Guidelines * Select all the materials you require for your experiment and add them to your
shopping list.
» To access and use the Applied Biosystems Store:
— Confirm that your computer has an Internet connection.
— Use the following Applied Biosystems-recommended browsers and versions of

Adobe® Acrobat® Reader:

Desktop ® Microsoft® . ® Adobe®

Operating Nets_cape Internet Macmto'_sh Acrobat®
Navigator Safari

System Explorer Reader

Windows® v6.x or later v6.x or later Not applicable v4.0 or later
2000/NT/XP/Vista

Macintosh® Not supported = Not supported | v2.0.4 or later v4.0 or later

OS 9+ or later

IMPORTANT! Make sure that cookies and Java Script are turned on.

For More For more information on completing the Experiment Materials List screen, access the
Information 7500 Software Help by clicking @ or pressing F1.

Notes
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Finish the Design Wizard

Finish the Design Wizard

To finish the Design Wizard, review the plate layout, then select an exit option.

About the The 7500 software automatically selects locations for the wells in the reaction plate. In
Example the presence/absence experiment:

Experiment » The wells are arranged as shown below.

&) Review Plate Layout for Experiment “Presence Absence Example®

a Review the plate layout, then select what you want to do next.
Save Experiment Start Run for This Experiment Eut Plate Layout e SR e Return to the Wizard
Using the Design Wizard
Save and close this Save this experiment, then Use Advanced Setup to edit Save and close this Continue designing this
experiment. startthe run. Make sure the the plate layout experiment, then create experiment using the Design
reaction plate is loaded into another experiment using the Wizard
the instrument Design Wizard
Show in Wells ¥ | View Legend ‘

T ]z I 5 ] @ 7 8 9 mo] 12
[T Pethes...|[] Pathog...| ] Pathos...| ] Pathos-.. [f] Pathos- ] Petres-- [T Pathos - | [T] Pathea.- | ] Pathos- ] Pathos-- | ] Pethos-- [T Pathos

[ IPC 7 Las == 1or == ior == 1or == 1or == 1or == 1or == ior == 1or == 1or == ior
m Pathog... m Pathog... Pathog m Pathog... Pathog... Pathog... Pathog m Pathog m Pathog... Pathog... Pathog... Pathog

[ IPC [T s == 1or == ior == ior == 1or == 1or == 1or == ior == 1or == 1or == 1or
¢ |71 Pathea...| 7] Pathea... [ Pathog..| [T] Pathoa... [T Pathos-. [f] Pathos-- | Psthee-- | [T] Pathos - | [T] Pethoa-- [T Pathos- | [T Pthos-- | [ P=thon

[ IPC EaIrc = 1or == ior = ior = 1or = 1or = 1or o = 1or = 1or = 1or
[ |71 Patheg...| 7] Paihes... [ Pathog..| [T] Pathoa... [T Pathos-.. [I] Pathos-|[] Paihcs. [T] Pathos-| [T] Patoa- [T Pathos.- | [I] Pathos-- | [I] Pathon

[ IPC [T L == 1or == ior == 1or == 1or == 1or === 1or == ior == 1or == 1or == 1or
n Pathog... H Pathog... Pathog m Pathog... Pathog... Pathog... Pathog m Pathog m Pathog... Pathog... m Pathog... Pathog

[ IPC Ea IrC e —ior = oe = ior e —or —ior = ior o —or
[T Pathes... [] Pathog..| ] Pathos...|[T] Pathos... [f] Pathos-.. [] Petves.. [T Pathos - | [T] Pathes.- | ] Patos- [I] Pathos-- | ] Pethes-- [T Pathos

[ IPC 7 L == 1or === ior == 1or === 1or == 1or === 1or === ior === 1or == 1or == 1or
n Pathog... H Pathog... Pathog m Pathog... Pathog... Pathog... Pathog m Pathog m Pathog... Pathog... m Pathog... Pathog

[ IPC [l IFc == 1or == ior == ior == 1or == 1or == 1or === ior == 1or == 1or == ior
i |71 Pathea...| 7] Pathea... [ Pathos...| [T] Pathoa... [T Pathos- [f] Pathos-- | Psthee- | [T] Pathos-| [T] Pethoa- [T Pathos- | [T Pathos-- | [ P=thon

[ IrC 7 Las = 1or o = 1or = 1or = 1or = 1or o = 1or = 1or = 1or

» The experiment is saved as is and closed.

Note: For the example experiment, do not perform the run at this time.

Notes

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence 33

Experiments



m Chapter 2 Design the Experiment

Finish the Design Wizard

Finishthe 1. At the bottom of the 7500 software screen, click Finish Designing Experiment.

Design Wizard ) _ _ )

2. In the Review Plate Layout for Experiment window, review the plate layout. Make

sure there are:

80 Unknown-IPC @

+ 8 Negative Control-Blocked IPC & [

8 Negative Control-IPC [
Note: If the plate layout is incorrect, click Return to the Wizard and check your
entered values.

3. Click Save Experiment.

4. In the Save Experiment dialog box, enter Presence Absence Example Setup.eds in
the File name drop-down list, then click Save. The example experiment is saved and
closed, and you are returned to the Home screen.

IMPORTANT! Do not save the experiment using the default file name. Doing so
will overwrite the example experiment already present in the experiments folder.
Note: By default, the example experiment is saved to the <drive>:\Applied
Biosystems\<software name>\experiments folder.
& save Experiment Presence Absence Example
Save in |ﬁ'| experiments V‘ IEII:_'A_\@I@
De;mup
.
e
My Computer
.Ei} File name: | Presence Absence Example.cds | | save J' 4
My MNetwaork
Places Files of type |ExpenmentDocumentswngleﬂ\es(".eds) V| | cances ]
Notes
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Finish the Design Wizard

Design  When you design your own presence/absence experiment:

Guidelines * In the Review Plate Layout for Experiment window, select the appropriate exit option:

Click To...

Save Experiment Save and close the experiment without making any
further changes or starting the run.

Start Run for This Experiment Save the experiment and start the run. Make sure the
reaction plate is loaded in the instrument.

Edit Plate Layout Use Advanced Setup to edit the plate layout.

Create Another Experiment Save and close the current experiment, then create

Using the Design Wizard another experiment using the Design Wizard.

Return to the Wizard Return to the experiment to make changes using the
Design Wizard.

* By default, experiments are saved to:
<drive>:\Applied Biosystems\<software name>\experiments
To change the:

— Save location for a specific experiment — Navigate to the desired location using
the Save Experiment dialog box.

— Default save location — Select Tools » Preferences, then select the Defaults tab.
In the Data Folder field, browse to then select the desired location.

For More For more information on using Advanced Setup, see “Advanced Setup Workflow” on
Information page 92.

Notes
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Chapter 3

Prepare the Reactions

This chapter covers:

B Chapter OVEIVIEW . . . o\ttt ettt et e e e e e e et ettt 38
B Prepare the Template. .. ... . e 39
B Prepare the Samples . . ... 40
B Prepare the Reaction MiX . .. ... ...t 42
B Prepare the Reactions . . .......... ... i 44

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Chapter Overview

Chapter Overview

This chapter explains how to prepare the PCR reactions for the presence/absence
example experiment and provides guidelines for how to prepare the PCR reactions for
your own presence/absence experiment.

Example The workflow for preparing the PCR reactions for the example experiment provided with
Experiment this getting started guide is shown below.
Workflow

Start Experiment

v
Design the Experiment (Chapter 2)
v

Prepare the Reactions (Chapter 3)

Prepare the template.
Prepare the samples.
Prepare the reaction mix.

A~

Prepare the reactions.

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

End Experiment

Notes
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Prepare the Template

Prepare the Template

In this section, prepare the DNA template for the PCR reactions using the PrepMan®
Ultra Sample Preparation Reagent kit.

About the For the presence/absence example experiment, the template for the PCR reactions is
Example DNA extracted from bacteria found in ground beef. There are 10 samples of ground beef
Experiment to analyze for the presence or absence of a pathogen.

Required * DNA isolated from blood, tissue culture cells, and buccal swabs.
Materials « DNA isolated from animal or plant tissue.

Purified plasmid DNA.

* One of the products listed below for DNA isolation:

Kit* Part Number
PrepMan® Ultra Sample Preparation Reagent Kit 4322547
NucPrep® DNA Chemistry for Tissues 4340274
BloodPrep® Chemistry for Blood, Tissue Culture Cells, 4346860
and Buccal Swabs
Plasmid Miniprep Kit 402790

I Applied Biosystems recommends using the kits with the ABI Prism® 6100 Nucleic Acid
PrepStation or the ABI Prism® 6700 Nucleic Acid Automated Workstation.

Prepare the Use the DNA isolation kits recommended in the table above, or follow your own protocol
Template toisolate DNA.

Preparation When you prepare your own presence/absence experiment, extract DNA from the tissue
Guidelines or sample. Ensure that the DNA you use:

* Has a A,q)5 ratio of greater than 1.7.

* Has a stock concentration of 100 ng/uL.

 Is extracted from the raw material you are testing using an optimized protocol.
* Does not contain PCR inhibitors.

» Is intact as visualized by gel electrophoresis.

» Has not been heated above 60 °C.

For More Applied Biosystems supplies several chemistries for isolating DNA from blood, tissue,
Information cell cultures, plant material, and food. For more information refer to:

* DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal Swabs
Protocol

*  NucPrep® Chemistry Isolation of Genomic DNA from Animal and Plant Tissue Protocol
* PrepMan® Ultra Sample Preparation Reagent Protocol

Notes

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence 39
Experiments



m Chapter 3 Prepare the Reactions

Prepare the Samples

Prepare the Samples

Notes

40

In this section, dilute the DNA samples using the volumes that were calculated by the
7500 software.

About the For the presence/absence example experiment, 2.5 puL. of 50 ng/uL. sample DNA is added
Example to22.5 uL of Reaction Mix. The final reaction volume per well is 25 pL. For all wells
Experiment containing sample DNA, the final concentration of DNA per well is 5 ng/uL, and the

total amount of DNA per well is 100 ng.

For the presence/absence example experiment:

Required .
Materials .

The stock concentration of sample (Unknown) DNA, after preparing the template, is

100 ng/uL.

The desired concentration of sample (Unknown) DNA to add to the reaction is

50 ng/uL.

The reaction volume per well is 25 pL.

The excess reaction volume is 10%.

The volumes calculated in the software are:

Stock

Total Volume

Sample . Sample Diluent .
Concentration of Diluted
Name (ng/uL) Volume (pL) Volume (pL) Sample (uL)
Unknown 1 100 11.0 11.0 22.0
Unknown 2 100 11.0 11.0 22.0
Unknown 10 100 11.0 11.0 22.0

Buffer or water to dilute the sample

Microcentrifuge tubes

Pipettors
Pipette tips
Sample stock
Vortexer
Centrifuge

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence
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Prepare the Samples

Prepare the 1. Label a separate microcentrifuge tube for each unknown sample:

Sample Dilutions « Unknown 1
e Unknown 2
e Unknown 3
e Unknown 4
e Unknown 5
e Unknown 6
* Unknown 7
e Unknown 8
e Unknown 9
¢ Unknown 10

2. Add the required volume of water to each empty tube:

Tube Sample Name Diluent Volume (uL)
1 Unknown 1 11.0
2 Unknown 2 11.0
10 Unknown 10 11.0

3. Add the required volume of sample stock to each empty tube:

Tube Sample Name Sample Volume (pL)
1 Unknown 1 11.0
2 Unknown 2 11.0
10 Unknown 10 11.0

4. Vortex each sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reactions.

Notes
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Prepare the Reaction Mix

Prepare the Reaction Mix

Prepare the reaction mix using the components and volumes that were calculated by the
7500 software (“Complete the Reaction Mix Calculations Tab” on page 27).

Note: The reaction mix includes all components except sample and negative control
(buffer or IPC blocking agent).

About the All samples contain a primer and probe set for the IPC and a primer and probe set for the
Example pathogen, therefore, only one reaction mix is required.

Experiment . . .
P The reaction mix components and volumes calculated in the software are:

Component Volume (pL) for 1 Reaction

TagMan® Universal PCR Master Mix (2.0X) or 12.50
TagMan® Universal PCR Master Mix, No Amperase® UNG

10X IPC Mix 2.50
50X IPC DNA 0.50
20X Primer/Probe Mix | 1.25
Water/Buffer 5.75
Total Reaction Mix Volume 22.50

Note: The sample is not added at this time.

Required * Microcentrifuge tubes

Materials « Pipettors
* Pipette tips
» Reaction mix components (listed above)
* Centrifuge

Prepare the _ (FX111{e]'] CHEMICAL HAZARD. TagMan® Universal PCR Master Mix

Reaction Mix may cause eye and skin irritation. Exposure may cause discomfort if swallowed or
inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate
protective eyewear, clothing, and gloves.

_ (JX111[e]{] CHEMICAL HAZARD. TagMan® 2X Universal PCR Master

Mix, No AmpErase UNG may cause eye and skin irritation. Exposure may cause
discomfort if swallowed or inhaled. Read the MSDS, and follow the handling
instructions. Wear appropriate protective eyewear, clothing, and gloves.

Notes

42 Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence
Experiments




Chapter 3 Prepare the Reactions m
Prepare the Reaction Mix

1. Label an appropriately sized tube for the reaction mix: Pathogen Reaction Mix.

2. Add the required volumes of each component to the tube:

componare Vel Vb )20 e
TagMan® Universal PCR 12.50 1320.0

Master Mix (2.0X)

10X IPC Mix 2.50 264.0

50X IPC DNA 0.50 52.80

20X Primer/Probe Mix 1.25 132.00
Water/Buffer 5.75 607.20

Total Reaction Mix Volume 22.50 2376.00

3. Mix the reaction mix by gently pipetting up and down, then cap the tube.
4. Centrifuge the tube briefly.

5. Place the reaction mix on ice until you prepare the reactions.

Preparation When you prepare your own presence/absence reactions:

Guidelines * Prepare the reaction mix for each target separately.

* Include excess volume in your calculations to provide excess volume for the loss
that occurs during reagent transfers.

* Include all required components.
* Prepare the reagents according to the manufacturer’s instructions.

» Keep the TagMan probe protected from light, in the freezer, until you are ready to
use it. Excessive exposure to light may affect the fluorescent probes.

* Prior to use:
— Mix the master mix thoroughly by swirling the bottle.
— Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

— Thaw any frozen samples by placing them on ice. When thawed, resuspend the
samples by vortexing, then centrifuge the tubes briefly.

Notes
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Prepare the Reactions

Prepare the Reactions

Prepare the reactions using the volumes that were calculated by the 7500 software. See
“Review the Reaction Setup” on page 27.

About the For the presence/absence experiment:
Example + A MicroAmp® Optical 96-Well Reaction Plate is used.

Experiment : . .
P The final concentration of DNA for all of the samples is 5 ng/pL.
* The reaction volume is 25 pL/well.
* The reaction plate contains:
— 8 Negative Control-Blocked IPC [ [
— 8 Negative Control-TPC [
— 80 Unknown-IPC [1]
» The plate layout that the 7500 software automatically generates is used:
&) Review Plate Layout for Experiment “Presence Absence Example™ @
u Review the plate layout, then select whatyou want to do next.
Save Experiment Start Run for This Experiment Edit Plate Layout C[::; &”f;:;i::ﬁ;::‘t Return to the Wizard ‘
Save and close this Save this experiment, then Use Advanced Setup to edit Save and close this Continue designing this
experiment. startthe run. Make sure the the plate layout. experiment, then create experiment using the Design
reaction plate is loaded into another experiment using the Wizard.
the instrument. Design Wizard
Show in Wells v | View Legend ‘ ‘
12 ] 3 [ 4 [ s [ & [ 7 [ & [ & | 1w | n | 12 |
a H Pathog... m Pathog... m Pathog... m Pathog... m Pathog... m Pathog.. m Pathog... m Pathog... m Pathog... m Pathog... m Pathog... m Pathog..
4 IPC T Ko e o o o o —or e e o o
B n Pathog... m Pathog... m Pathog... m Pathog... m Pathog... m Pathog.. m Pathog... m Pathog... m Pathog... m Pathog... m Pathog... m Pathog..
[ IPC T Las e e o o o —or e e o o
c n Pathog... H Pathog... m Pathog... m Pathog... m Pathog... m Pathog.. m Pathog... m Pathog... m Pathog... m Pathog... m Pathog... m Pathog..
[ IPC T Las e e o o o —or e e o o
D H Pathog... m Pathog... m Pathog... m Pathog... m Pathog... m Pathog.. m Pathog... m Pathog... m Pathog... m Pathog... m Pathog... m Pathog..
4 IPC T Ko e o o o o —or e e o o
E H Pathog... ﬂ Pathog... m Pathog... m Pathog... m Pathog... m Pathog.. m Pathog... m Pathog... m Pathog... m Pathog... m Pathog... m Pathog..
4 IPC T Ko e o o o o —or e e o o
F H Pathog... ﬂ Pathog... Pathog... Pathog... m Pathog... m Pathog.. m Pathog... Pathog... m Pathog... m Pathog... Pathog... Pathog..
[ IPC T Kas e o o o o —or e e o o
G n Pathog... H Pathog... m Pathog... m Pathog... m Pathog... m Pathog.. m Pathog... m Pathog... m Pathog... Pathog... m Pathog... m Pathog..
[ IPC I PC e o o o o —or o e o o
H m Pathog... m Pathog... Pathog... m Pathog... m Pathog... m Pathog.. m Pathog... m Pathog... m Pathog... m Pathog... Pathog... m Pathog..
[ IPC T Las e e = o o o —or e =i o o
Notes
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Prepare the Reactions

Required * Pipettors
Materials « Pipette tips
» Pathogen reaction mix (from page 42)
*  Water or buffer
» Samples (from page 41)
+ MicroAmp® Optical 96-Well Reaction Plate
+ MicroAmp™™ Optical Adhesive Film
» Centrifuge

Prepare the Use the plate layout and instructions to prepare the PCR reactions. Make sure the
Reactions arrangement of PCR reactions matches the plate layout in the software:

1. Add 22.5 pL of reaction mix to the appropriate wells.

Reaction Mix Add 22.5 uL Reaction Mix to Wells

Pathogen A1, A2, A3, A4, A5, A6, A7, A8, A9, A10, A11, A12
B1, B2, B3, B4, B5, B6, B7, B8, B9, B10, B11, B12
C1, C2, C8, C4, C5, C6, C7, C8, C9, C10, C11, C12
D1, D2, D3, D4, D5, D6, D7, D8, D9, D10, D11, D12
E1, E2, E3, E4, E5, E6, E7, E8, E9, E10, E11, E12
F1, F2, F3, F4, F5, F6, F7, F8, F9, F10, F11, F12
G1, G2, G3, G4, G5, G6, G7, G8, G9, G10, G11, G12
H1, H2, H3, H4, H5, H6, H7, H8, H9, H10, H11, H12

2. Prepare Negative Control-IPC reactions (Task = NC-IPC): Add 2.5 pL of buffer or
water to the appropriate wells.

Add 2.5 pL Buffer or Water to Wells

A2, B2, C2, D2, E2, F2, G2, H2

3. Prepare Negative Control-Blocked IPC reactions (Task = NC-Blocked IPC):
Add 2.5 pLL of IPC blocking agent to the appropriate wells.

Add 2.5 pL Blocking Agent to Wells

A1, B1, C1, D1, E1, F1, G1, H1

Notes
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Prepare the Reactions

4. Prepare unknown reactions (Task = Unknown): Add 2.5 uL of sample to the
appropriate wells.

Sample Add 2 pL Sample to Wells
Unknown 1 A3, B3, C3, D3, E3, F3, G3, H3
Unknown 2 A4, B4, C4, D4, E4, F4, G4, H4
Unknown 3 A5, B5, C5, D5, E5, F5, G5, H5
Unknown 4 A8, B6, C6, D6, E6, F6, G6, H6
Unknown 5 A7,B7,C7,D7, E7, F7, G7, H7
Unknown 6 A8, B8, C8, D8, E8, F8, G8, H8
Unknown 7 A9, B9, C9, D9, E9, F9, G9, H9
Unknown 8 A10, B10, C10, D10, E10, F10, G10, H10
Unknown 9 A11, B11, C11, D11, E11, F11, G11, H11
Unknown 10 A12,B12,C12, D12, E12, F12, G12, H12

5. Cover the reactions with the appropriate consumable:
* Optical reaction plate — Seal the reaction plate with optical adhesive film.
» Tube strips — Cover the tubes with caps.

6. Centrifuge the tubes briefly to remove air bubbles.

7. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of time.

IMPORTANT! Do not allow the bottom of the reaction plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block and cause an abnormally high background signal.

Correct Incorrect
- — ] . -3
II i
| {
III ||
| II
IIII III
) w W
Liquid is at the ¢ Not centrifuged with enough force, or
bottom of the well. |« Not centrifuged for enough time

8. Until you are ready to perform the run, place the reaction plate on ice in the dark.

Notes
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Prepare the Reactions

Preparation When you prepare your own presence/absence experiment:
Guidelines » Wear appropriate protective eyewear, clothing, and gloves.
» Make sure you use the appropriate consumables.

* Make sure the arrangement of the PCR reactions matches the plate layout in the
7500 software. You can either:

— Accept the plate layout automatically generated by the 7500 software.
or
— Use Advanced Setup to change the plate layout in the software (page 92).
» If you use optical adhesive film, seal each reaction plate as follows:

a. Place the reaction plate onto the center of the 96-well base.
b. Load the reaction plate as desired.

c. Remove a single optical adhesive film (film) from the box.

Fold back one of the end-tabs. Hold the film with its backing
side up.

d. In one continuous movement, peel back the white
protective backing from the center sealing surface. Do not
touch the center sealing surface.

IMPORTANT! Improper peeling of the optical adhesive film may result in
haziness, but does not affect results. Haziness disappears when the film comes
into contact with the heated cover in the instrument.

e. While holding the film by the end-tabs, lower the film onto
the reaction plate (adhesive side facing the reaction plate).
Be sure the film completely covers all wells of the reaction
plate.

f. While applying firm pressure, move the applicator slowly
across the film, horizontally and vertically, to ensure good
contact between the film and the entire surface of the
reaction plate.

g- While using the applicator to hold the edge of the film in
place, grasp one end of the end-tab and pull up and away
sharply. Repeat for the other end-tab.

h. Repeat step fto ensure a tight, evaporation-free seal. While
applying firm pressure, run the edge of the applicator
along all four sides of the outside border of the film.

Note: Optical adhesive films do not adhere on contact. The films require the
application of pressure to ensure a tight seal.

Notes
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Prepare the Reactions

i. Inspect the reaction plate to be sure all wells are sealed. You should see an
imprint of all wells on the surface of the film.

For More For more information on:
Information » Consumables — See “Supported Consumables” on page 4.

» Using Advanced Setup to change the plate layout — See “Advanced Setup
Workflow” on page 92.
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n Run the Experiment

This chapter covers:

B Chapter OVEIVIEW . . . o\ttt et e e e e e e e e e e ettt 50
B Prepare forthe Run....... ... ... .. . . . . 51
B Enable the Notification Settings (Optional) . . ........... ... .. ... .. ..... 53
B Startthe Run.......... . .. . .. . 55
B Monitorthe Run . ... ... . . . 55
B Unload the Instrument . ............ ... .. . ... 57

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Chapter Overview

Chapter Overview

This chapter explains how to perform a run on the Applied Biosystems 7500/7500 Fast
Real-Time PCR System.

Example The workflow for running the example experiment provided with this getting started
Experiment guide is shown below.
Workflow
Start Experiment

v
Design the Experiment (Chapter 2)

v
Prepare the Experiment (Chapter 3)

v
Run the Experiment (Chapter 4)

. Prepare for the run.
. (Optional) Enable the notification settings.
. Start the run.

. Monitor the run.

O WO N =

. Unload the instrument.

v
Analyze the Experiment (Chapter 5)

v
End Experiment

Notes
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Prepare for the Run

Prepare for the Run

Prepare for the run by opening the example experiment file you created in Chapter 2,
then loading the sealed reaction plate into the 7500/7500 Fast instrument.

Open the 1. Double-click 3 (7500 software) or select Start » All Programs »

Example Applied Biosystems » 7500 Software » <software name>
Experiment where <software name> is the current version of the 7500 software.
2. Inthe Home screen, click Open.

3. In the Open dialog box, navigate to the experiments folder (default):

<drive>:\Applied Biosystems\<sofiware name>\experiments

4. Double-click Presence Absence Example Setup.eds to open the example
experiment file you created in Chapter 2.

Load the AWARNING PHYSICAL INJURY HAZARD. During operation, the sample

Reaction Plate block can be heated to 100 °C. Before performing the following procedure, be sure to
Into the  wait until the sample block reaches room temperature.
Instrument

@ﬂ" ] IMPORTANT! Wear powder-free gloves when you handle the reaction plate.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

7500 system 7500 Fast system

Load standard plates with Load Fast plates with the
the notched A12 position at notched A1 position at the
the top-right of the tray. top-left of the tray.

Notes
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Prepare for the Run

3. Place the reactions in the precision plate holder (PPH). If you use:
* A reaction plate — Place the reaction plate in the PPH with well A1 at the

back-left corner.

Note: Fast Reaction 8-tube strips can be used only on the 7500 Fast system.
For the 7500 system, use MicroAmp® Optical 8-Tube Strips.

Reaction tube strips — Place the tube strips in the PPH for tube strips.

Note: Fast Reaction tubes cannot be used in the 7500 Fast system.

Reaction tubes — Place the tubes in the PPH.

Note: MicroAmp® Fast Reaction Tubes (PN 4358297) cannot be used in the
7500 Fast system.

IMPORTANT! For optimal performance with partial loads:

For a 7500 Instrument

Load at least 16 tubes, arranging them first in the center columns of the
instrument system (columns 6 and 7). Move outward towards columns 1 and 12
as you add more tubes.

For a 7500 Fast Instrument

* Place empty tube strips in columns 1 and 12 to prevent crushing of tubes
containing samples.

* Place tube strips with samples in the PPH vertically, starting in columns 6
and 7 and moving outward.

* A maximum of 6 tube strips can be used in the 7500 Fast instrument.
Leave columns 2, 3, 10, and 11 empty.

4. Close the tray. Apply pressure to the right side of the tray and at an angle.
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Enable the Notification Settings (Optional)

Enable the Notification Settings (Optional)

Enable the notification settings so that the 7500 software alerts you via e-mail when the
7500/7500 Fast instrument begins and completes the run, or if an error occurs during the
run. Enabling the notifications settings feature is optional and does not affect the
performance of the 7500/7500 Fast system or the duration of the run.

IMPORTANT! The notification settings feature is available only if the computer that you are
using is running the 7500/7500 Fast instrument and is connected to an Ethernet network.

About the In the example experiment:

Exa_mple * The 7500 software is set up to send notifications to three users (scientist, supervisor,
Experiment and technician at mycompany.com) when the 7500/7500 Fast system ends the run
and if it encounters any errors during operation.

* The example SMTP server (www.mycompany.com) is set up for secure sockets
layer (SSL) encryption and requires authentication for use.

—h

Set Up the
Notification
Settings

. In the 7500 software, click @ Run in the navigation pane.
Click (5} Notification Settings.

Select Yes for Enable Notifications.

0N

Select the events that will trigger notifications:
a. Select Instrument Error.

b. Select Run Completed.
5. In the Enter e-mail addresses for notifications field, enter:
scientist@mycompany.com, supervisor@mycompany.com,
technician@mycompany.com.

6. In the Outgoing Mail Server (SMTP) field, enter smtp.mycompany.com.

7. Set the authentication settings:

a. Select Yes for Server requires authentication.

b. In the User Name field, enter Example User.

c. In the Password field, enter password.

Notes
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Notification Settings

|
Enable Nofifications: 3 Yes O No

‘ Select the events to generate notifications Instrument Error

L [J Run Started

Run Completed

Enter &-mail for notificati ompany.com, supervi: pany.com, jici y.com

Separate e-mail addresses with commas
For example: jane_smith@mydomain.com,awong@bigmailhost.com

7a

Outgoing Mail Server (SMTP): | smip.mycompany.com
For example: smip.mycompany.com

Server requires an encrypted connection? O Yes &) Mo

7b
7c

|
Senver requires authentication? & Yes O No

(Server Authentication) User Name |Examme User ‘

(Sever Password; [ |

Run Guidelines When you set up the 7500/7500 Fast system for automatic notification:

Notes

Your system must be set up for network use. Refer to the Applied Biosystems 7500/7500
Fast Real-Time PCR System Maintenance Guide.

Select the events for which you want to receive e-mail notifications. Select:

— Instrument Error — To notify recipients by email of all errors encountered by
the instrument during each run.

— Run Started — To notify recipients by email when the instrument starts a run.

— Run Completed — To notify recipients by email when the instrument completes a
run.

Obtain e-mail addresses to receive notifications.

IMPORTANT! Separate addresses with a comma (,).

Contact your systems administrator or information technology department if you
need:

— E-mail addresses for users who will receive notifications

— A network address for a simple mail transfer protocol (SMTP) server on the LAN
— A user name and password for the server, if required for access

— The Secure Sockets Layer (SSL) setting of the server (on or off)

54
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Start the Run

Start the Run

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not create
experiments, perform maintenance, or allow the computer to run antivirus software or to
enter hibernation mode. Performing such activities while the instrument is running an
experiment will cause gaps in data collection.

To start your 7500/7500 Fast instrument:
1. In the 7500 software, click W:__@; Run in the navigation pane.

2. Click START RUN Ji.

Monitor the Run

You can view the progress of the run in real time as described below. During the run,
periodically view all three available plots from the 7500 software for potential problems.

To... Action

Stop the run 1. In the 7500 software, click STOP RUN.

2. In the Stop Run dialog box, click one of the following:
— Stop Immediately to stop the run immediately.

— Stop after Current Cycle/Hold to stop the run after the
current cycle or hold.

— Cancel to continue the run.

View amplification data | Select w Ampilification Plot.

in real time See “About the Amplification Plot Screen” on page 55.
View progress of the Select |~ Run Method.

run in the Run Method See “About the Run Method Screen” on page 56.
screen

Enable/disable the Select or deselect Enable Notifications.

Notification Settings See “Enable the Notification Settings (Optional)” on page 53.

About the Ampilification Plot Screen

The screen displays sample amplification as your instrument collects fluorescence data
during a run. If a method is set up to collect real-time data, the Amplification Plot screen
displays the data for the wells selected in the View Plate Layout tab. The plot contrasts
normalized dye fluorescence (ARn) and cycle number. The figure below shows the
Amplification Plot screen as it appears during the example experiment.

To view data in the Amplification Plot screen, select the wells that you want to view in
the View Plate Layout tab.

Notes
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Monitor the Run

Amplification Plot €| View Plate Layout
i 4 SelectWells With: |- Select tem- |
PlotTyne: aRnvs Cycle ¥| GraphType:|Log | PlotColor|Targst v — —
| |2 ShowinWells ¥ | [ View Legend
Save current settings as the default
o P2 B R = 1 ? 3 4 & 6 7 B 8 10 11 12
- ! [T I I I I I I I I I I
Amplification Pict PR TR e = T = T i i i i =
1 ) ! - I... nI I... I... nI I... I... nI I... I...
T D s ceowey HREDWS MRSTRS GRIRS SRS GRS SRR SRSE
- D.D‘II
% I . c 4! Wl I... nI I... I... nI I... I... nI I... I...
| i R ==t == == = =S = =
0.0001 |
‘ ) [ T I I I I I I I I I I I
0.000001 1 <HiEG ) TGS ey Fayy Py Py Py P Py P Ry ey
2 4 [} a 10 12 14 16 18 W 2 M X W/ I X M ¥ B’ A
Cycle o Pzt r T 0 I T T T T
IR A e e e e e e e e e
-
Pathogen PC P oz v IS T Sy (T S T T T
TR B sy ey s s ATy TS SRS ST S
OMIDI'IS\ s EIP glp I... nI I... I... nI I... I... nI I... I...
TargeI:Threshold: o [ ] [JAuloBaselin® ——0—C—0—0—0—C—0 ¢
o o b H 4 - I... nI I. I... nI I. I... nI I... I...
< | kd RIEER === = — = — i —

The Amplification Plot screen is useful for identifying and examining abnormal
amplification. Abnormal amplification can include the following:

* Increased fluorescence in negative control wells.
» Absence of detectable fluorescence at an expected cycle (determined from previous
similar experiments run using the same reagents under the same conditions).

If you notice abnormal amplification or a complete absence of fluorescence, troubleshoot
the error as explained in the 7500 Software Help (click @ or press F1).

About the Run Method Screen

The screen displays the run method selected for the run in progress. The software updates
the Run Status field throughout the run. The figure below shows the Run Method screen
as it appears in the example experiment.

To... Action
A | Change the number of cycles In the Extend # of Cycles field, enter the number of
cycles to apply to the Cycling Stage.
B | Apply your changes Click Send to Instrument.
Notes
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Unload the Instrument

Run Method

Edit Run Method

Pre-PCR Read (Holding Stage) Holding Stage

Bdtend#orcyces [ | A
Cycling Stage SR R
l Send to Instrument |—— B

Enable AutoDelta

starting Cycle: [0 |

100 —|

75 —|

50 —|

25 —|

Step 1 Step 1 Step 1 Step 2
<

>
end

Leg
Data Collection On Data Collection Off A AutoDelfta On A AutoDelta Off ‘

If an alert appears, click the error for more information and troubleshoot the problem as
explained in the 7500 Software Help (click @ or press F1).

Unload the Instrument

When your 7500/7500 Fast system displays the Run Complete message, unload the
reaction plate from the instrument.

Unload the AWARNING PHYSICAL INJURY HAZARD. During operation, the sample

Reaction Plate block can be heated to 100 °C. Before performing the following procedure, be sure to
wait until the sample block reaches room temperature.

1. Push the tray door to open it.
2. Remove the reaction plate.

3. Push the tray door to close it.

Notes
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Unload the Instrument

Notes
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Chapter 5

Analyze the Experiment

This chapter covers:

B Chapter OVEIVIEW . . . o\ttt et e e e e e e e e e e ettt 60
Section 5.1 ReviewResults............coiiiiiiiiiiiiiiiiiiiiiiinenenn. 61
B Analyze the Experiment .. ............ .. i 62
B View the Presence/Absence Plot. . ........ ... ... .. . 65
B View the Amplification Plot. . ... ... .. .. ... .. . .. . . .. 67
B Viewthe Well Table .. ........ ... . . . . i, 74
B Publishthe Data ....... ... ... . . . 77
Section 5.2 Troubleshoot (If Needed) ........cciiiiiiiiiiiiiiieneennenns 79
B View the Analysis Settings . . .. ...t 80
B View the QC SUmMmAary. .. ...ttt et e 82
B Omit Wells from the Analysis. .. ........ ... . ... 84
B View the Multicomponent Plot. . ......... ... .. ... .. ... .. ... .. 86
B Viewthe RawDataPlot .. ...... ... ... . . . . i 88

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.
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Chapter Overview

Notes

60

The 7500 software analyzes your data using the endpoint method. Section 1 of this
chapter explains how to review the analyzed data using several of the analysis screens
and how to publish data. If you receive questionable results, Section 2 of this chapter
explains how to perform some troubleshooting steps.

Example The workflow for analyzing the example experiment provided with this getting started

Experiment guide is shown below.
Workflow

Start Experiment
v
Design the Experiment (Chapter 2)

v
Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v

o s W N

Analyze the Experiment (Chapter 5)

Section 1, Review Results:
1. Analyze the experiment.

2. View the presence/absence plot.
3.
4
5

View the amplification plot.

. View the results in a table.

. Publish the Data.

Section 2, Troubleshoot (If Needed):
1.

. View the quality summary.

View the analysis settings.

Omit wells.

View the multicomponent plot.

. View the raw data plot.

v

End Experiment
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Section 5.1 Review Results

This section covers:

B Analyze the Experiment .. ............. ... i 62
B View the Presence/Absence Plot. .. ........ ... ... .. ... ... ... ... .. ... ... 65
B View the Amplification Plot. .. ...... ... ... ... ... . .. . . . . 67
B Viewthe Well Table . ... ... .. . .. . . . . 74
B Publishthe Data .. ....... .. ... . . . . e 77
Notes
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Analyze the Experiment

Analyze the Experiment

The 7500 software analyzes the experiment and displays results in the analysis screens
(for example, the Amplification Plot screen or the QC Summary screen).

About the For the presence/absence experiment, use the data file that installs with the 7500
Example software. The data file was created with the same design parameters that are provided in
Experiment Chapter 2, then run and analyzed on a 7500/7500 Fast system.

You can find the data file for the example experiment on your computer:

<drive>:\Applied Biosystems\<sofiware name>\experiments\

Presence Absence Example.eds

where:
* <drive> is the computer hard drive on which the 7500 software is installed.
» <software name> is the current version of the 7500 software.

Analyze the 1. Double-click ; (7500 Software) or select Start » All Programs »
Example Applied Biosystems » 7500 Software » <software name>
Experiment

where <software name> is the current version of the 7500 software.
2. From the Home screen, click Open.

3. In the Open dialog box, double-click the experiments folder:

<drive>:\Applied Biosystems\<software name>\experiments

4. Double-click Presence/Absence Example.eds to open the example experiment data
file.

Note: The experiments folder contains several data files; be sure to select Presence
Absence Example.eds.

5. In the navigation pane, click Analysis. The 7500 software analyzes the data using
the default analysis settings.

See “Navigation Tips” on page 63 for information on navigating within the analysis
screens.

Analysis Settings

Experiment Menu<¢ | Fxperime . Presence Absence Fxample Ty Presence/Absence Reagen  TagMan® Reagents

' Setup Amplification Plot <[ View Plate Layout | View wel Table |
u Plot Settings 4 SelectWells With: |- Setect tem - v || |
5 : & Plot Type:|ARn vs Cycle | Graph Type:lLog | PlotColor: Target ~| | ooy | = —— | | |
| | o A A-A-A-A-A- - - -
Notes
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Analyze the Experiment

Guidelines When you analyze your own presence/absence experiment:

» Immediately after a run, the 7500 software automatically analyzes the data using the
default analysis settings, then displays the Presence/Absence Plot on your computer.

» To reanalyze the data, select all the wells in the plate layout, then click Analyze.

Navigation Tips How to Select Wells

To display specific wells in the analysis screens, select the wells in the View Plate
Layout tab as follows:

1. To select wells of a specific type, use the Select Wells With drop-down lists: Select
Sample, Target, or Task, then select the sample, target, or task name.

2. To select one well, click the well in the plate layout.

3. To select multiple wells, click and drag over the desired wells, or CTRL-click, or
press Shift-click in the plate layout.

4. To select all 96 wells, click the top left corner of the plate layout.

> | View Plate Layouq View Well Table ]

SelectWells with: | Selectitem - v ||

1 | 2 | 3 | 1 | 3 | B | 7 | 8 | 9 [0 T [ 12 ]

| | Show in Wells ¥ | View Legend

EBE

A 7 @re @ @ @ @ @ @ @ @ e

[ Petheaen [ Patheg=n i pothogen - [7] Pathogen - [7] Pathogen - [ Pathogen - [T Pathogen - [7] Psthogen - [] Pathegen 4, [7] Pathogen - [T] Psthogen g [ Pathogen 4,

=

I~ B T B T Hre H|re Hre ore H|re @re gre Hre @re
[ Patheaen - [7] Patheg=n i pothogen - [7] Pathogen - [7] Psthogen - [] Pathogen - [T Pathogen - [7] Psthogen - [ Pathogen 4, [T] Pathogen g [T] Pathogen g [ Pathogen 4,
e TIE : g o ; e e St

[ Petheaen - [7] Patheg=n i pthogen - [7] Pathogen - [7] Pathogen - [7] Pathogen - [T Pathogen - [T] Psthogen - [] Pathegen 4, [7] Pathogen g [T] Pathogen g [ Pathogen 4,

m

@ Ere @re @ @ @ g e e @ @ @ @

D TRz 10 D il [T Pathegen -, [ Pathogen =[] Psthegen - [ Psthogen =, [T] Pathegen - [T Psthesen -, [ Pathegen g [T] Pathogen g [ Patheasn g [T Pathemsn g

=]

| zgee IGE IPC "\‘;;:mm % .rl.;:...m X IPC "\‘;c IPC IPC "\‘;c IPC IPC

[ Patheaen - [7] Patheg=n i pthogen - [7] Pathogen - [7] Pathogen - [7] Pathogen - [T Pathogen - [7] Psthogen - [] Pathegen - [7] Pathogen g, [T] Pathogen g [ Pathogen 4,

m

Hre Ere @re @ @ @ mre e @ @ @ @

[ Patheaen - [7] Patheg=n i pothogen - [7] Pathogen - [7] Psthogen - [] Pathogen - [T Pathogen - [7] Psthogen - [ Pathogen 4, [T] Pathogen g [T] Pathogen g [ Pathogen 4,

-n

e Hre @re @ @ @ e @re @ @ @ e

[ Petheaen [ Patheg=n i pothogen - [7] Pathogen - [7] Pathogen - [ Pathogen - [T Pathogen - [7] Psthogen - [] Pathegen 4, [7] Pathogen - [T] Psthogen g [ Pathogen 4,

@

| ggee ([ IPC "\‘;;:mm $ .rl.;:...m . IPC "\‘;c IPC IPC "\‘;c IPC IPC

H
D TRz 10 D il [T Pathegen -, [ Pathogen =[] Psthegen - [ Psthogen =, [T] Pathegen - [T Psthesen -, [ Pathegen g [T] Pathogen g [ Patheasn g [T Pathemsn g

‘Wells: 0 Unknown 0 NC | 80 Unknown-IPC 8 NC-IPC 8 NC-Blocked IPC 0 Empty

Analysis Summary:  Total Wells in Plate: 96 Wells SetUp:96  Wells Omitted Manually: 0 Wells Flagged: 0 Wells Omitted by Analysis: 0 Samples Used: 10 Targets Used: 2

Notes
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Notes

Analyze the Experiment

How To Display Multiple Plots

Use the Multiple Plots view to display up to four plots simultaneously. To navigate

within the Multiple Plots view:

1. From the navigation pane, select Analysis » |5

2. To display four plots, click 22 Show plots in a 2 X 2 matrix.

3. To display two plots in rows, click = Show plots in two rows.

Multiple Plots View.

4. To display two plots in columns, click (|| Show plots in two columns.

5. To display a specific plot, select the plot from the drop-down list above each plot

display.
5 2 3
S m-—4
A
Presence/Absence Results v] [nmpiication Piot - ARnvs Cycle v
— - ot o TR 5=
B s i & E A P Al ]
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View the Presence/Absence Plot

The Presence/Absence plot displays the intensity of the fluorescence for each well
position. There are four Presence/Absence plot views available:

* All Calls
* Presence calls only
* Absence calls only

¢ Unconfirmed calls

For each view, you can choose to:
* Show IPC
+ Show Controls

About the In the presence/absence experiment:

Exa_mple » The target is absent in samples Unknown 1, Unknown 2, Unknown 3, Unknown 4,
Experiment Unknown 5, and Unknown 6.

* The target is present in samples Unknown 7, Unknown 8, Unknown 9, and
Unknown 10.

¢ There are no unconfirmed wells.
¢ The IPC succeeded in all wells.

View the 1. From the navigation pane, select Analysis » Presence/Absence Plot.

Presence/
Absence Plot Note: If no data are displayed, click Analyze.

2. For an expanded display of the 96 wells of the Presence/Absence Plot, click % in
the upper left corner of the plate layout in the View Plate Layout tab.

<[ View Plate Layout | View WellTable |
22—

SelectWells With: |- Select tem - -

| EIShowinWellsv | ViewLegend

|

+,

[ 1 2 3 4 5 6

From the Target Reporter drop-down list, select Pathogen.
From the Control Reporter drop-down list, select IPC.

From the Show Calls drop-down list, select All Calls.

o o kb

Click the = (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Notes
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7. Click the Show IPC check box to view the fluorescence intensity of the IPC target
in the Unknown-IPC wells.

8. Click the Show Controls check box to view the fluorescence intensity of the IPC
target in the Negative Control-IPC wells and the Negative Control-Blocked IPC
wells.

9. To view the fluorescence intensity of only the presence calls, select Presence from
the Show Calls drop-down list.

10. To view the fluorescence intensity of only the absence calls, select Absence from
the Show Calls drop-down list.

11. To view the fluorescence intensity of only the unconfirmed calls, select
Unconfirmed from the Show Calls drop-down list. The presence/absence example
experiment does not contain unconfirmed calls.

Presence/Absence Plot

Plot

3 TafgelREDDneflf_athgggn v Show IPC [ | " 7
4 Control Repnnerﬁpc v_: Show Controls [} 8
5 Show Calls | "
[AH Calls ﬂ
—_— = Wt |—. =
m®) B8Rk 6
Presence/Absence Results
B0
@
50
® (]
40
® ] ® ® a
g ® .5 ® ®
E a0 @@ L L
® ® L
® L et
20 @ @ @ @ @
]
10
Target Threshald
LEEEE == RSO e Py L T L = Moeccon & WESg
0o L] - 1] 1] - - - -

50
‘Well Position

IPC Cails: I 1PC Faled

Legend
Urikniaan Cafls: @) Presance & Amnce 7 Uncardrmed
PG Succonded
Carteois W Hegaive Carted g Bocked PC Carirad

Analysis  When you analyze your own experiment, review the presence/absence plot for:
Guidelines * The IPC threshold — this value is calculated from the Negative Control-Blocked
IPC reactions.

* The Target Threshold — this value is calculated from the Negative Control-IPC
reactions. If the target’s intensity is:

— Above the target threshold, the call is present (regardless of the intensity of the IPC).

— Below the target threshold, and the IPC’s intensity is above the IPC threshold, the
call is absent.

Notes
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— Below the target threshold, and the IPC’s intensity is below the IPC threshold, the
call is unconfirmed.

» Target Calls:
— Presence
— Absence
— Unconfirmed
» IPC Calls:
— IPC Succeeded
— IPC Failed
* Control Well Calls:
— Negative Control - [PC
— Negative Control - Blocked IPC

For More For more information on the Presence/Absence Plot screen, access the 7500 Software
Information Help by clicking @ or pressing F1.

View the Amplification Plot

Note: The amplification plot is available only if the Run Method included an
amplification stage that included data collection. For more information, see “About Data
Collection” on page 2, “Set Up the Run Method” on page 25, and “About the
Amplification Plot Screen” on page 55.

The amplification plot displays amplification of all samples in the selected wells. There
are three amplification plot views available:

* ARn vs Cycle — ARn is the difference in normalized fluorescence generated by the
reporter between the pre-PCR read and the post-PCR read. This plot displays ARn
as a function of cycle number. You can use this plot to identify and examine
irregular amplification and to view threshold and baseline values for the run.

* Rn vs Cycle — Rn is the fluorescence from the reporter dye normalized to the
fluorescence from the passive reference. This plot displays Rn as a function of cycle
number. You can use this plot to identify and examine irregular amplification.

* C; vs Well — C; is the PCR cycle number at which the fluorescence equals the
threshold in the amplification plot. This plot displays C as a function of well
position. You can use this plot to locate outlying amplification (outliers).

IMPORTANT! Amplification plots are not used to make presence/absence calls. Examine
the plots to help with troubleshooting and quality control.

Notes
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About the In the presence/absence example experiment, you review the amplification plot for:

Exa_mple » Correct baseline and threshold values
Experiment o
¢ Irregular amplification

¢ Qutliers

View the 1. From the navigation pane, select Analysis » Amplification Plot.
Amplification
Plots Note: If no data are displayed, click Analyze.

2. Display all 96 wells in the amplification plot by clicking the upper left corner of the
plate layout in the View Plate Layout tab.

3. For an expanded display of the Amplification Plot, click » in the upper left corner
of the plate layout in the View Plate Layout tab.

3 2
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Analysis Summary: Total Wells in Plate: 96 Wells Set Up: 98 Wells Omitted Manually: 0 Wells Flagged:0  Wells Omitted by Analysis: 0 Samples Used: 10 Targets Used: 2

4. In the Amplification Plot screen:
a. From the Plot Type drop-down list, select ARn vs Cycle.
b. From the Plot Color drop-down list, select Well.
c. Click the §= (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button
changes to Hide the plot legend.

Notes
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d. From the Target dropdown menu, select AlL

5. View the baseline values:
a. From the Graph Type drop-down list, select Linear.
b. Select the Baseline check box to show the start cycle and end cycle.

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescence is detected. In
the example experiment, the baseline is set correctly.

4a 5a 4b 4¢

R ||

Plot

|
Plot Type:|ARnvs Cycle % | Graph Type:|Linear | Plot Color:/Well V—l

Save current settings as the default

P pa ;!

Amplification Plot

ARn

Leged

A B lc D ME Hr Hoc HH

4d : |
Options
Target: Al 3 Threshold: [JAuto [ | []Auto Baseline
Show: [#] Threshold — [7] Baseling Start Well M Target 4 Baseline End: Well (M Target 4.
5b
6. View the threshold values:
a. From the Graph Type drop-down list, select Log.
b. Select the Threshold check box to show the threshold.
c. Verify that the threshold is set correctly.
Notes
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Amplification Plot

Plot
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I}
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6b a
7. Locate any outliers:
a. From the Plot Type drop-down list, select Cy vs Well.
b. Look for outliers from the amplification plot.
Plot Setti
Plot Type:[CTvs Wall | Graph Type:[ oo | Plot Color: well ~|
7a ‘
urrent settings as the default
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Analysis When you analyze your own presence/absence experiment, look for:
Guidelines . Qutliers

* A typical amplification plot — The 7500 software calculates baseline and threshold
values based on the assumption that the data exhibit a typical amplification curve. A
typical amplification plot has four distinct sections:

a. Plateau phase
b. Linear phase

. Exponential (geometric phase)

(2}

o

. Baseline

0210658
Threshold

0.1

ARN

o0.01

i A1 «]C
| { |
A\ S S PN O BT M
4 a a 10 12 ||¢ 1R Hmom ” 24 RO AN il KT R £ an &£ d

Cycle

0.0001

0.001 ":?_ .
X

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the 7500 software. Therefore, Applied Biosystems
recommends that you examine the Amplification Plot and review the assigned
baseline and threshold values for each well after analysis completes.

* Correct baseline and threshold values — See the threshold examples on page 72 and
the baseline examples on page 73.

Notes
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Threshold Examples

Threshold Set Correctly 0

The threshold is set in the exponential phase of the
amplification curve.

Threshold settings above or below the optimum increase _
the standard deviation of the replicate groups. 0242796

Threshold Set Too Low 0

The threshold is set below the exponential phase of the
amplification curve. The standard deviation is significantly
higher than that for a plot where the threshold is set
correctly. Drag the threshold bar up into the exponential
phase of the curve.

Fn

Threshold Set Too High CE

The threshold is set above the exponential phase of the

amplification curve. The standard deviation is significantly flazadzaz
higher than that for a plot where the threshold is set '
correctly. Drag the threshold bar down into the i
exponential phase of the curve.

ARn

e e Vil H e

Notes
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Baseline Examples

Baseline Set Correctly

The amplification curve begins after the maximum
baseline.

Baseline Set Too Low

The amplification curve begins too far to the right of the -
maximum baseline. Increase the End Cycle value. s

Baseline Set Too High

The amplification curve begins before the maximum = ;
baseline. Decrease the End Cycle value. 3 y,

If your experiment does not meet the guidelines above:

* Manually adjust the baseline and/or threshold (see “View the Analysis Settings” on
page 80).
or

* Omit wells, (see “Omit Wells from the Analysis” on page 84).

For More For more information on the Amplification Plot screen, access the 7500 Software Help
Information by clicking @ or pressing F1.

Notes
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View the Well Table

The Well Table displays results data for each well in the reaction plate, including:
* The well number, sample name, target name, task, and dyes
e The calculated values: ARn, ARn mean, and ARn SD

Note: ARn, ARn mean, and ARn SD are calculated only when the analysis call
settings specify to analyze data from the pre-PCR read and the post-PCR read.

» Target and IPC thresholds, Call, Comments
» Flags

About the In the presence/absence example experiment, you review the Well Table for:
Example . (a1
Experiment . ARn

* Flag

View the Well 1. From the navigation pane, select Analysis, then select the View Well Table tab.

Table
Note: If no data are displayed, click Analyze.

2. For an expanded display of the Well Table, click ¢ in the upper left corner of the
plate layout in the View Plate Layout tab.

3. Use the Group By drop-down list to group wells by a specific category. For the
example experiment, group the wells by flag, call, and ARn value.

Note: You can select only one category at a time.

a. From the Group By drop-down list, select Flag. In the example experiment,
96 wells are listed under Unflagged.

»| View Plate Layout | View Well Table ]

SelectWells With: - Selectiter -+
| Show in Table ¥ | Group By ¥ | Expand Al Collapse All
3a : j
# | well Omit | Flag Sample Target Task Dyes ARn | ARnMean | ARnSD | Threshold Call Com Ct
F__'l__a_aged Wells ~
[ Unflagged Wells |
1 Al O IPC BlockedIPC  VIG-HFO-MGB 0 0004 0003 Blocked IPC Gontrol 400
2 Al O Pathogen NTC FAMLNFO-MGE 0015 0008 0008 Negative Control 400
3 a2 O PG PG VIC-NFQ-MGB 5473 5607 0111 IPG Succesded 27104261
4 a2 O Pathogen NTC FAM-NFO-MGE 0332 0286 0047 Negative Control 400
5 A O Unknown 1 IPG IPC VIC-NFQ-MGB 5312 5484 0136 0.006 IPG Succesded 27 065914
& A O Unknown1  Pathogen UNKNOWN FAM-NFO-MGE 0288 0232 0048 045 Absence 400
7 MO Unknown 2 PG PG VIC-NFQ-MGB 5385 5476 0076 0.006 IPG Succesdad 27 149246
] MO Unknown 2 Pathogen UNKNOWN FAM-NFO-MGE 0282 0218 0046 045 Absence 400
g A O Unknown 3 IPG IPC VIC-NFG-MGB 5371 5455 0048 0.006 IPG Succesded 26985441
10 A O Unknown3  Pathogen UNKNOWN FAM-NFO-MGE 028 0204 0038 045 Absence 400
11 M O Unknown 4 PG PG VIC-NFQ-MGB 5182 5384 DDEY 0.006 IPG Succesdad 27 027546
12 M O Unknown 4  Pathogen UNKNOWN FAM-NFO-MGE 0278 0183 0037 045 Absence 400
13 a7 O Unknown & PG IPC VIC-NFG-MGB 5311 54 0048 0.006 IPG Succesded 2710312
14 a7 O Unknown &  Pathogen UNKNOWN FAM-NFO-MGE 0 255 0204 0028 045 Absence 400
15 A O Unknown 6 PG PG VIC-NFQ-MGB 5383 5472 0027 0.006 IPG Succesdad 27 054825
16 A T Unknown &  Pathogen UNKNOWN FAM-NFO-MGE 0 286 027 0037 045 Absence 400
Notes
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b. From the Group By drop-down list, select Call. Wells are listed in the order:
* Absence
* Blocked IPC Control
e [PC Failed
* IPC Succeeded
* Negative Control
* Presence
* Unconfirmed
* No Call

View Plate Layout | View Well Table ]

Select Wells With: |- Selectftem - v | | |
| Show in Table ¥ | Group By ¥ | Expand Al Gollapse All
!
# | Well Omit | Flag Sample Target Task Dyes ARn | ARnMean | ARnSD | Threshold. Call Com Ct
kL] <R ] Unknown1  Pathogen UNKNOWN FAM-NFO-MGE 0 256 0232 0048 045 Absence 400 ~
40 s O Unknown 2  Pathogen UNKNOWN FAM-NFO-MGE 022 0218 0046 045 Absence 400
41 55 O Unknown3  Pathogen UNKNOWN FAM-NFO-MGE 0178 0204 0038 045 Absence 400
42 a6 O Unknown 4  Pathogen UNKNOWN FAM-NFO-MGE 0179 0183 0037 045 Absence 400
43 57 O Unknown & Pathogen UNKNOWN FAM-NFO-MGE 0172 0204 0028 045 Absence 400
44 8 [O Unknown &  Pathogen UNKNOWN FAM-NFO-MGE 0187 027 0037 045 Absence 400
45 10 [ Unknown &  Pathogen UNKNOWN FAM-NFO-MGE 0233 2004 1378 045 Absence 400
46 H3 O Unknown 1 Pathogen UNKNOWN FAM-NFO-MGE 0279 0232 0048 045 Absence 400
47 He O Unknown?  Pathogen UNKNOWN FAM-NFO-MGE 0259 0218 0046 045 Absence 400
48 Hs O Unknown3  Pathogen UNKNOWN FAM-NFO-MGE 024 0204 0038 045 Absence 400
48 HE O Unknown 4  Pathogen UNKNOWN FAM-NFO-MGE 0218 0185 0037 045 Absence 400
50 W7 O Unknown &  Pathogen UNKNOWN FAM-NFO-MGE 0218 0204 0028 045 Absence 400
51 HE O Unknown &  Pathogen UNKNOWN FAM-NFO-MGE 0239 0217 0037 045 Absence 400
=l Blocked IPC Contral
52 Al O IPC BlockedIPC  VIG-HFO-MGB 0 0004 0003 Blocked IPC Control 400
53 B O IPC BlockedIPC  VIC-NFO-MGB -0 004 0004 0003 Blocked IPC Control 400
54 1 O IPC BlockedIPC  VIG-NFG-MGB -0 008 0004 0003 Blocked IPC Control 400
55 ot O IPC BlockedIPC  VIG-NFO-MGB -0 004 0004 0003 Blocked IPC Gontrol 400
56 £ O PG BlockedIPC  VIC-NFG-MGB -0 003 0004 0003 Blocked IPC Control 400
57 Fi O IPC BlockedIPC  VIG-NFG-MGB -0 003 0004 0003 Blocked IPC Control 400
58 1 O IPC BlockedIPC  VIG-NFG-MGB -0 001 0004 0003 Blocked IPC Control 400
58 H O IPC BlockedIPC  VIG-NFG-MGB -0 008 0004 0003 Blocked IPC Gontrol 400
= TPC Succeeded
&0 a2 O IPC PG VIC-NFQ-MGB 5473 5607 0111 IPG Succesded 27104261
&1 a0 Unknown 1 IPG PG VIC-NFQ-MGB 5312 5484 0136 0.006 IPG Succesded 27 065414
] MO Unknown 2 PG PG VIC-NFQ-MGB 5385 5476 0076 0.006 IPG Succesded 27149246
63 A O Unknown 3 IPG IPC VIC-NFQ-MGB 5371 5455 0049 0.006 IPG Succesded 26 985441
64 M O Unknown 4 PG IPC VIC-NFQ-MGB 5182 5384 DDEY 0.006 IPG Succesdsd 27 027546
A5 ) Unknown & IPC IPC IC-HEQ-MGE A 311 A4 004 000/ |PC: Succeeded 1031 b
Notes
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c. From the Group By drop-down list, select None. In the table, click the column
heading ARn. Wells are listed in order of increasing ARn. Click the column
heading again to reverse the sort order.

»| View Plate Layout | View Well Table ]

SelectWells With: |- Selectitem - +
[ snow nTasie v | eroupsy v | 5 5
L
# | well Omit | Flag Sample Target Task Dyes ARnMean | ARnSD | Threshold Call Comments | Gt
1 c1 O IFC BlockedIPC  VIC-NFQ-MGB -0.008 -0.004 0.003 Blocked IPC Control 400 &
2 Hi O IFC BlockedIPC  VIC-NFQ-MGB -0.008 -0.004 0.003 Blocked IPC Control 400
a o O IFC BlockedIPC  VIC-NFQ-MGB -0.004 -0.004 0.003 Blocked IPC Control 400
4 Bl O IFC BlockedIPC  VIC-NFQ-MGB -0.004 -0.004 0.003 Blocked IPC Control 400
H FE1 O IFC BlockedIPC  VIC-NFQ-MGB -0.003 -0.004 0.003 Blocked IPC Control 400
& F1 O IFC BlockedIPC  VIC-NFQ-MGB -0.003 -0.004 0.003 Blocked IPC Control 400
W G O IFC BlockedIPC  VIC-NFQ-MGB -0.001 -0.004 0.003 Blocked IPC Control 400
8 61 O Pathogen NTC FAM-NFQ-MGB -0.001 0.008 0.008 MNegative Control 400
g Al O IFC BlockedIPC  VIC-NFQ-MGB -0 -0.004 0.003 Blocked IPC Control 400
10 F1 O Pathogen NTC FAM-NFQ-MGB 0 0.008 0.008 Negative Control 400
11 o1 O Pathogen NTC FAM-NFQ-MGB 0.003 0.008 0.008 MNegative Control 400
= E1 O Pathogen NTC FAM-NFQ-MGB 0.008 0.008 0.008 MNegative Control 400
13 o O Pathogen NTC FAM-NFQ-MGB 0.01 0.008 0.008 MNegative Control 400
14 H1 O Pathogen NTC FAM-NFQ-MGB 0.01 0.008 0.008 MNegative Control 400
185 Al O Pathogen NTC FAM-NFQ-MGB 0.015 0.008 0.008 MNegative Control 400
16 B1 O Pathogen NTC FAM-NFQ-MGB 0.021 0.008 0.008 MNegative Control 400
i D3 O Unknown 1 Pathogen URNKMOWN  FAM-NFQ-MGB 0.152 0.232 0.048 0.45 Absence 400
18 E4 O Unknown 2 Pathogen UNKMOWN  FAM-NFQ-MGB 0.154 0.218 0.048 0.45 Absence 400
19 D6 O Unknown 4 Pathogen UNKMOWN  FAM-NFQ-MGB 0.162 0.199 0.037 0.45 Absence 400
20 F8 O Unknown &  Pathogen UNKMOWN  FAM-NFQ-MGB 0.166 0217 0.037 0.45 Absence 400
21 F& O Unknown 3 Pathogen URNKMOWN  FAM-NFQ-MGB 0.166 0.204 0.038 0.45 Absence 400
22 F6 O Unknown 4 Pathogen UNKMOWN  FAM-NFQ-MGB 0.169 0.199 0.037 0.45 Absence 400
23 D4 O Unknown 2 Pathogen UNKMOWN  FAM-NFQ-MGB 0171 0.218 0.048 0.45 Absence 400
24 G7 O Unknown &  Pathogen UNKMOWN  FAM-NFQ-MGB 0172 0.204 0.028 0.45 Absence 400
25 G5 O Unknown 3 Pathogen URNKMOWN  FAM-NFQ-MGB 0178 0.204 0.038 0.45 Absence 400
26 G6 O Unknown 4 Pathogen UNKMOWN  FAM-NFQ-MGB 0179 0.199 0.037 0.45 Absence 400
BE  F7 O Unknown &  Pathogen UNKMOWN  FAM-NFQ-MGB 0178 0.204 0.028 0.45 Absence 400
28 E5 O Unknown 3 Pathogen UNKMOWN  FAM-NFQ-MGB 0181 0.204 0.038 0.45 Absence 400
29 F4 M Unknown 7 __Pathooen  UNKMOWN _FAM-NFQ-MGH 0181 il 1547 048 Absence 400 i

Analysis When you analyze your own presence/absence experiment, group the wells by:

Guidelines » Flag —The software groups the flagged and unflagged wells. A flag indicates that

the software found an error in the flagged well. For a description of the 7500
software flags, see “View the QC Summary” on page 82.

» Call — The software groups the wells by call: Negative Control, Blocked-IPC,
Presence, Absence, Unconfirmed, IPC Succeeded, IPC Failed, and No Call.

How to Use the Plate Layout to View Calls

You can use the Plate Layout to display presence/absence calls, and to select the data
displayed in the Presence Absence Plot. To:

 Change the data displayed in the Plate Layout — Click [@ ] Show in Wells, then
select (or deselect) the data that you want the Plate Layout to display.

» Select wells based on the sample, target, or task — In the Select Wells With drop-
down lists, select Sample, Target, or Task, then select the sample, target, or task
name. The 7500 software selects the associated wells in the Presence Absence Plot.

For More For more information on the Well Table, access the 7500 Software Help by clicking @
Information or pressing F1.

Notes
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Publish the Data

You can publish the experiment data in several ways:
» Save the plot as an image file
* Print the plot
* Print the plate layout
* Create slides
* Print a report
» Export data

For More For information on performing these procedures, access the 7500 Software Help by
Information clicking @ or pressing F1.

Notes
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Notes
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Section 5.2 Troubleshoot (If Needed)

This section covers:

B View the Analysis Settings . . .. ...ttt 80
B View the QC SUMMATY. . . ..o\ttt et e et e e e e 82
B Omit Wells from the Analysis. . .......... ... i 84
B View the Multicomponent Plot. . ....... ... .. ... ... .. ... ... ... .. .. ..... 86
B Viewthe Raw DataPlot . ...... ... ... ... . . . . . . 88
Notes
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View the Analysis Settings

The Analysis Settings dialog box displays the analysis settings for the call settings,
threshold cycle (Cy), and flags. If the default analysis settings in the 7500 software are
not suitable for your experiment, you can change the settings in the Analysis Settings
dialog box, then reanalyze your experiment.

About the In the presence/absence example experiment, the default analysis settings are used
Example without changes.
Experiment

Review the 1. From the navigation pane, select Analysis.

Analysis Settings , ) , )
2. Click Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:
* Call Settings
* C; Settings
» Flag Settings

& Analysis Settings for Presence Absence Example E]

[ Call §_§j(tj_n__g§___| Cr Settings I Flag Settings I Advanced Settings ]
5
u Review the default settings for analysis of targsts in this experiment.
To edit the default settings, click "Edit Default Settings." To use different settings for a target,
selectthe target from the table, deselect"Use Default Settings,” then change the settings that are displayed.

Data Analysis Settings

(2 Analyze Data from PostPCR Read Only (9 Analyze Data from Pre-PCR Read and PostPCR Read

Default Call Settings

Default call settings are used to make presence/ahsence calls for targets without custom settings. To editthe default seftings, click "Edit

Default Settings.”

Confidence Valug: 98% | Ecit Defaut Settings |

Select a Target Call Settings for Pathogen

Target Analysis Type Confidence Call Settings to Use Use Default Settings

~
Pathogen Default 99% = l:l
IPC Default 99%
v
Revert to Defautt Analysis Settings J Apply Analysis Settings J \ Cancel ]
Notes
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Analysis  Unless you have already determined the optimal settings for your experiment, use the
Guidelines default analysis settings in the 7500 software. If the default settings are not suitable for
your experiment, you can change the:

* Call Settings — Use this tab to specify whether to analyze data from the pre-PCR
read or to edit the default confidence value used to make presence/absence calls for
each target.

* C; Settings (if the experiment includes amplification) — Use this tab to set the
threshold and baseline either automatically or manually. When you manually set the
threshold and baseline, keep the following Applied Biosystems recommendations in

mind:
Setting Recommendation
Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
¢ Within the exponential phase of the amplification curve.
Baseline Select Start Cycle and End Cycle values so that the baseline ends

before significant fluorescence is detected.

* Flag Settings — Use this tab to:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the 7500 software.

For More For more information on the analysis settings, access the 7500 Software Help by clicking
Information @ or pressing F1 when the Analysis Settings dialog box is open.

Notes
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View the QC Summary

The QC Summary displays a list of the 7500 software flags. This summary includes the

flag frequency and location for the open experiment.

4.

From the navigation pane, select Analysis »

About the
Example
Experiment generated.
View the QC 1.
Summary

Note: If no data are displayed, click Analyze.

Review the Flag Summary.

QC Summary.

In the presence/absence example experiment, you review the QC Summary for any flags
generated by the experiment data. In the example experiment, no flags have been

In the Flag Details table, look in the Frequency and Wells columns to determine
which flags appear in the experiment.

(Optional) Click each flag row to display detailed information about the flag.

Hag v
Total Wells 96 | Processed Wells: 96 Manually Omitted Wells 0 | Targets Used: 2
Wells Set Up: 96 | Flagged Wells: 0 Analysis Omitted Wells: 0 | Samples Used: 10

Flag Details
[

Flag MName Freguency Wells
4 BADROX Bad passive reference signal 0
MOSIGNAL Mo signal in well 0
OFFSCALE Fluorescence is offscale 0
AMPNC Amplification in negative control i
MNOAMP Mo amplification 0
MOISE Moise higher than others in plate 0
SPIKE Moise spikes 0
EXPFAIL Exponential algorithm failed 0
BLFAIL Baseline algorithm failed 0
THOLDFAIL Thresholding algorithm failed 0
CTFAIL CT algorithm failed 0
Flag: BADROX—Bad passive reference signal
Flag Detail: Passive reference signal is abnormal
Flag Criteria: Fluorescence < 500.0
Flagged Wells: None
view BADRCK Troubleshooting
Information
Notes
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Possible Flags For presence/absence experiments, the flags listed below may be triggered by the
experiment data.

Note: If the experiment does not include amplification, then the only flags are
BADROX, NOSIGNAL, and OFFSCALE.

If a flag does not appear in the experiment, its frequency is 0. If the frequency is >0, the
flag appears somewhere in the experiment; the well position is listed in the Wells

column.
Flag Description
AMPNC Amplification in negative control
BADROX Bad passive reference signal
BLFAIL Baseline algorithm failed
CTFAIL | Cy algorithm failed
EXPFAIL Exponential algorithm failed
NOAMP No amplification
NOISE Noise higher than others in plate
NOSIGNAL No signal in well
OFFSCALE Fluorescence is offscale
SPIKE | Noise spikes
THOLDFAIL Thresholding algorithm failed

Analysis  When you analyze your own presence/absence experiment:

Guidelines * Click each flag in the Flag Details table with a frequency >0 to display detailed
information about the flag. If needed, click the troubleshooting link to view
information on correcting the flag.

* You can change the flag settings:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the 7500 software.

For More For more information on the QC Summary screen or on flag settings, access the 7500
Information Software Help by clicking @ or pressing F1.

Notes
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ﬂ Chapter 5 Analyze the Experiment
Omit Wells from the Analysis

Omit Wells from the Analysis

About the
Example
Experiment

Omit Wells

You may omit wells from analysis if you do not want to consider data generated by the
well.

In the presence/absence example experiment, there are no outliers; no wells need to be
removed from analysis.

1. Click the View Plate Layout tab.

2. Select one or more wells to omit from analysis.

3. Right-click the well(s), then select Omit. Results for the well are removed.

View Plate LayoutT View Well Table ]
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Notes

4. Click Analyze to reanalyze the data without the omitted wells.

Note: Alternatively, you can omit wells from the Well Table by selecting the
checkbox in the Omit column for the wells you want to remove from the analysis.
See “Analysis Guidelines” on page 85 for more information.
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Chapter 5 Analyze the Experiment ﬂ
Omit Wells from the Analysis

Analysis  When you analyze your own presence/absence experiment, carefully consider which
Guidelines  wells to omit from analysis. If needed, remove outliers manually using the Well Table.

1. From the navigation pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Inthe Amplification Plot screen, select C vs Well from the Plot Type drop-down
list.

3. Select the View Well Table tab.

4, Review the Well Table:
a. Look for any outliers.

b. Select the Omit check box next to the outlying well(s).

5. Click Analyze to reanalyze the experiment data with the outlying well(s) removed
from the analysis.

For More For more information on omitting wells from the analysis, access the 7500 Software
Information Help by clicking @ or pressing F1. Within the Help, search for the omit well topics:

1. Click the Search tab.
2. Enter omit well.

3. Click List Topics.

4

. Double-click the topics you want to review.

Notes

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence 85
Experiments



ﬂ Chapter 5 Analyze the Experiment
View the Multicomponent Plot

View the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye
in a selected well over the duration of a PCR run.

About the In the presence/absence example experiment, you review the Multicomponent Plot for:

Example .
Experiment

View the 1.

Multicomponent
Plot

Notes

ROX™ dye

VIC® dye

FAM™ dye

Spikes, dips, and/or sudden changes.

Amplification in the negative control wells.

From the navigation pane, select Analysis » || #¢ | Multicomponent Plot.

Note: If no data are displayed, click Analyze.

Display the wells one at a time in the Multicomponent Plot screen:
a. Click the View Plate Layout tab.
b. Select one well in the plate layout; the well is shown in the Multicomponent

Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

From the Plot Color drop-down list, select Dye.

Click the §= (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Check the ROX dye signal. In the example experiment, the ROX dye signal remains
constant throughout the run.

Check the VIC dye signal. In the example experiment, the VIC dye signal should
not amplify for NC-Blocked IPC wells or if the IPC call for the Unknown-IPC well
is IPC failed.

Check the FAM dye signal. In the example experiment, the FAM dye signal should
amplify for Unknown-IPC wells that receive a target call of Presence.
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View the Multicomponent Plot
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Analysis  When you analyze your own presence/absence experiment, look for:

Guidelines * Passive reference (ROX)- The passive reference dye fluorescence level should
remain relatively constant throughout the PCR process.

* Reporter dye (FAM) — The reporter dye fluorescence level should display a flat
region corresponding to the baseline. If target is present in the sample (a Presence
call is made), the baseline will be followed by a rapid rise in fluorescence as the
amplification proceeds.

* Any irregularities in the signal — There should not be any spikes, dips, and/or
sudden changes in the fluorescence.

* Negative control wells — There should not be any amplification in the negative
control wells.

For More For more information on the Multicomponent Plot screen, access the 7500 Software Help
Information by clicking @ or pressing F1.

Notes
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ﬂ Chapter 5 Analyze the Experiment

View the Raw Data Plot

View the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence (not normalized) for each
optical filter for the selected wells during each cycle of the real-time PCR.

About the In the presence/absence example experiment, you review the Raw Data Plot screen for a
Example stable increase in signal (no abrupt changes or dips) from the appropriate filter.

Experiment

View the Raw

Notes

88

Data Plot

1. From the navigation pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

. Click the §= (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Note: The legend displays the color code for each row of the reaction plate.

. Display all 96 wells in the Raw Data Plot screen by clicking the upper left corner of

the plate layout in the View Plate Layout tab.

. In the View Plate Layout tab, select wells corresponding to a replicate group. For:

* Unknown 1 wells: From the Select Wells with drop-down lists, select Sample and
Sample 1.

¢ Unknown 2 wells: From the Select Wells with drop-down lists, select Sample and
Sample 2.

* Unknown 3 wells: From the Select Wells with drop-down lists, select Sample and
Sample 3.

* Unknown 4 wells: From the Select Wells with drop-down lists, select Sample and
Sample 4.

* Unknown 5 wells: From the Select Wells with drop-down lists, select Sample and
Sample S.

* Unknown 6 wells: From the Select Wells with drop-down lists, select Sample and
Sample 6.

* Unknown 7 wells: From the Select Wells with drop-down lists, select Sample and
Sample 7.

* Unknown 8 wells: From the Select Wells with drop-down lists, select Sample and
Sample 8.

* Unknown 9 wells: From the Select Wells with drop-down lists, select Sample and
Sample 9.

* Unknown 10 wells: From the Select Wells with drop-down lists, select Sample
and Sample 10.
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View the Raw Data Plot

* Negative control-IPC wells: Select wells A2, B2, C2, D2, E2, F2, G2, and H2.

* Negative control-blocked IPC wells: Select wells A1, B1, C1, D1, E1, F1, G1,
and H1.

5. Click and drag the Show Cycle pointer from cycle 1 to cycle 42, and review the data
from each filter:

* The data from filter 1 correspond to the signal from FAM™ dye, the reporter
for the pathogen target. Increase indicates amplification of the target.

* The data from filter 2 correspond to the signal from VIC®dye, the reporter for
the IPC target. Increase indicates amplification of the IPC.

+ The data from filter 4 correspond to the signal from ROX"™ dye, which is used
as the passive reference.

6. Repeat steps 4 and 5 for each replicate group.

Raw Data Plot .
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The filters are:
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Notes
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View the Raw Data Plot

Analysis
Guidelines

For More
Information

When you analyze your own presence/absence experiment, look for the following in each

filter:
* Characteristic signal growth
* No abrupt changes or dips

For more information on the Raw Data Plot screen, access the 7500 Software Help by

clicking @ or pressing F1.
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Appendix A

“ Alternate Experiment Workflows &

This appendix covers:

B Advanced Setup Workflow . . ... ... 92
B QuickStart Workflow . . ... .. .. .. 93
B Template Workflow. . .. .. ... o 95
B Export/Import Workflow . ....... ... . ... . . 96

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Advanced Setup Workflow

Advanced Setup Workflow

When you create an experiment using Advanced Setup in the 7500 software, you can set
up the experiment according to your own design.

1. Double-click ; (7500 Software) or select Start » All Programs »
Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.

2. In the Home screen, click Advanced Setup.

Note: If you do not see the Advanced Setup icon, click the arrow beneath the
Design Wizard icon to expand the Set Up menu.

3. Complete the setup screens to set up a new experiment:

a. Click Experiment Properties (default), enter the experiment name, then
select the experiment properties.

b. Click Plate Setup:
Experiment Type Action
Genotyping Define the SNP assays, then assign them to wells in the

reaction plate.

All other experiments Define the targets, then assign them to wells in the
reaction plate.

c. Click Run Method, review the reaction volume and thermal profile, then
edit as needed.

d. Click Reaction Setup, review the components and calculated volumes for
the PCR reactions, then edit as needed.

e. (Optional) Click D Materials List, review the list of materials, then order
the materials you need to prepare the reaction plate.

4. Prepare the PCR reactions:

Experiment Type Prepare the...
Relative standard curve a. Template.
b. Sample dilutions.
Standard curve o )
c. Standard dilution series.
d. Reaction mix.
e. Reaction plate.
Comparative C; a. Template.
Genotyping b. Samp!e dl|l,|.'[I0nS.
c. Reaction mix.
Presence/absence d. Reaction plate.
Notes
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QuickStart Workflow

5. Run the experiment:

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not
create experiments, perform maintenance, or allow the computer to run antivirus
software or to enter hibernation. Performing such activities while the instrument is
running an experiment will cause gaps in data collection.

a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

6. Analyze the data:
a. Open the experiment in the 7500 software.
b. In the navigation pane, click Analysis.
c. If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

QuickStart Workflow

When you create an experiment using QuickStart, you can run the reactions on the
instrument with no reaction plate setup information.

1. Prepare the PCR reactions:

Experiment Type Prepare the...
Relative standard curve a. Template.
Standard curve b. Sample d||l{t|o.ns. .
c. Standard dilution series.
d. Reaction mix.
e. Reaction plate.
Comparative C; a. Template.
Genotyping b. Samp!e d||u‘t|ons.
c. Reaction mix.
Presence/absence d. Reaction plate.

2. QuickStart the experiment:

a. Double-click 3 (7500 Software) or select Start » All Programs »
Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.
Notes
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QuickStart Workflow

b. In the Home screen, click zQ QuickStart.

c. Select the Experiment Properties tab (default), enter the experiment name,
then select the experiment properties.

d. Select the Run Method tab, review the reaction volume and thermal profile,
then edit as needed.

3. Run the experiment:

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not
create experiments, perform maintenance, or allow the computer to run antivirus
software or to enter hibernation. Performing such activities while the instrument is
running an experiment will cause gaps in data collection.

a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

4. In the 7500 software, complete the plate setup:

Experiment Type Select and complete the...

Genotyping a. Define SNP Assays and Samples tab.
b. Assign SNP Assays and Samples tab.

All other experiments a. Define Targets and Samples tab.
b. Assign Targets and Samples tab.

5. Analyze the data:
Open the experiment in the 7500 software.

a.
b. In the navigation pane, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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Template Workflow

Template Workflow

You can use a template to create a new experiment. Templates allow you to create many
experiments with the same setup information.

Createa 1. Double-click ; (7500 Software) or select Start » All Programs »
Template Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.

2. Open an existing experiment, or create a new experiment.

Note: You can create a new experiment using the Design Wizard (see Chapter 2) or
Advanced Setup (see page 92).

3. Seclect File » Save As Template.

4. Enter a file name, select a location for the template, then click Save.

5. Click &I Close.

Create an 1. In the Home screen, click Template.

Experiment with a
Template Note: If you do not see the Template icon, click the arrow beneath the Design

Wizard icon to expand the Set Up menu.

2. Locate and select the template you created above, then click Open. A new
experiment is created using the setup information from the template:

* Experiment properties
* Plate setup

* Run method

* Reaction setup

3. (Optional) If you want to modify the experiment, use Advanced Setup (see page 92).

4. Click [d Save, enter a file name, then click Save to save the experiment.

Notes
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Export/Import Workflow

5. Prepare the PCR reactions:

Experiment Type Prepare the...
Relative standard curve a. Template.
Standard curve b. Sample dI|L.ItIO.nS. .
c. Standard dilution series.
d. Reaction mix.
e. Reaction plate.
Comparative Cy a. Template.
Genotyping b. Samp!e dllultlons.
c. Reaction mix.
Presence/absence d. Reaction plate.

6. Run the experiment:

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not
create experiments, perform maintenance, or allow the computer to run antivirus
software or to enter hibernation. Performing such activities while the instrument is
running an experiment will cause gaps in data collection.

a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

7. Analyze the data:
a. Open the experiment in the 7500 software.
b. In the navigation pane, click Analysis.
c. If'the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Export/Import Workflow

Use the Export/Import workflow to set up a new experiment using setup data exported
from another experiment. Only reaction plate setup data are exported and imported.

Export Setup 1. Double-click ; (7500 Software) or select Start » All Programs »
Data Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.

Notes

96 Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Presence/Absence
Experiments



Appendix A Alternate Experiment Workflows n
Export/Import Workflow

2. Open an existing experiment, or create a new experiment.

Note: You can create a new experiment using the Design Wizard (see Chapter 2) or
Advanced Setup (see page 92).

3. Select File » Export.

4. Select the Export Properties tab (default), then:
Select Setup.

a.
b. Select One File in the drop-down list.

o

Enter a name, then select a location for the export file.

d. Select [} (*.txt) in the File Type drop-down list.

IMPORTANT! You cannot export *.xml files.

5. (Optional) Click the Customize Export tab, then select the appropriate options.
6. Click Start Export.

7. When prompted, click Close Export Tool.

Create an  You can import plate setup data from an exported text file (*.txt) to complete the reaction
Experiment with plate setup data for your experiment.
an Exported Text
File IMPORTANT! Be sure the exported text file you select contains only reaction plate setup
data and that the experiment types match.

1. Import the reaction plate setup data from an exported text file:

a. Using a spreadsheet application (such as Microsoft® Excel software), open an
exported text file.

b. Replace the parameters of the text file as needed. When finished, save the file
as a tab-delimited text file.

c. In the Home screen, click Advanced Setup.

Note: If you do not see the Advanced Setup icon, click the arrow beneath the
Design Wizard icon to expand the Set Up menu.

d. Create a new experiment or open an existing experiment.
e. Select File » Import.

f. Click Browse, locate and select the text file (*.txt), then click Select.

Notes
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Export/Import Workflow

g. Click Start Import. The setup data from the exported text file is imported into
the open experiment.

Note: If your experiment already contains plate setup information, the software
asks if you want to replace the plate setup with the data from the text file. Click Yes
to replace the plate setup.

2. Use Advanced Setup to finish setting up your experiment (see page 92).

3. Prepare the PCR reactions:

Experiment Type Prepare the...
Relative standard curve a. Template.
Standard curve b. Sample d|IL.1t|o.ns. .
c. Standard dilution series.
d. Reaction mix.
e. Reaction plate.
Comparative C; a. Template.
Genotyping b. Samp!e dI|U.tI0nS.
c. Reaction mix.
Presence/absence d. Reaction plate.

4. Run the experiment:

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not
create experiments, perform maintenance, or allow the computer to run antivirus
software or to enter hibernation. Performing such activities while the instrument is
running an experiment will cause gaps in data collection.

a. Load the reaction plate into the instrument.

b. Start the run

c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.
5. Analyze the data:

Open the experiment in the 7500 software.

a.
b. In the navigation pane, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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Advanced Setup

AIF
allele

allelic
discrimination plot

amplicon

amplification

amplification
efficiency (EFF %)

amplification plot

Glossary

In the 7500/7500 Fast system software, a feature that allows you to set up your experiment
according to your experiment design. Advanced Setup provides you with maximum
flexibility in the design and setup of your experiment.

See assay information file (AIF).
For a given target, any of the different sequences that occurs in the population.

Display of data collected during the post-PCR read. The allelic discrimination plot is a
graph of the normalized reporter signal from the allele 1 probe plotted against the
normalized reporter signal from the allele 2 probe.

A segment of DNA amplified during PCR.

Part of the instrument run in which PCR produces amplification of the target. For
quantitation experiments, fluorescence data collected during amplification are displayed in
an amplification plot, and the data are used to calculate results. For genotyping or
presence/absence experiments, fluorescence data collected during amplification are
displayed in an amplification plot, and the data can be used for troubleshooting.

Calculation of efficiency of the PCR amplification. The amplification efficiency is
calculated using the slope of the regression line in the standard curve. A slope close to
—3.32 indicates optimal, 100% PCR amplification efficiency. Factors that affect
amplification efficiency:

* Range of standard quantities — To increase the accuracy and precision of the
efficiency measurement, use a broad range of standard quantities, 5 to 6 logs
(10° to 10° fold).

* Number of standard replicates — To increase the precision of the standard quantities
and decrease the effects of pipetting inaccuracies, include replicates.

* PCR inhibitors — PCR inhibitors in the reaction can reduce amplification and alter
measurements of the efficiency.

Display of data collected during the cycling stage of PCR amplification. Can be viewed as:

» Baseline-corrected normalized reporter (ARn) vs. cycle
* Normalized reporter (Rn) vs. cycle
» Threshold cycle (Cy) vs. well
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amplification stage

assay

Assay ID

assay information
file (AIF)

assay mix

AutoDelta

automatic baseline

automatic C;

Part of the instrument run in which PCR produces amplification of the target. The
amplification stage is called a cycling stage in the thermal profile and consists of
denaturing, primer annealing, and polymerization steps that are repeated.

For quantitation experiments, fluorescence data collected during the amplification stage are
displayed in an amplification plot, and the data are used to calculate results. For genotyping
or presence/absence experiments, fluorescence data collected during the amplification
stage are displayed in an amplification plot, and the data can be used for troubleshooting.
See also cycling stage.

In the 7500/7500 Fast system, a PCR reaction mix that contains primers to amplify a target
and a reagent to detect the amplified target.

Identifier assigned by Applied Biosystems to TagMan® Gene Expression Assays and
TagMan® SNP Genotyping Assays.

Data file on a CD shipped with each assay order. The file name includes the number from
the barcode on the plate. The information in the AIF is provided in a tab-delimited format.

PCR reaction component in Applied Biosystems TagMan® Gene Expression Assays and
TagMan® SNP Genotyping Assays. The assay mix contains primers designed to amplify a
target and a TagMan® probe designed to detect amplification of the target.

In the run method, a setting to increase or decrease the temperature and/or time for a step
with each subsequent cycle in a cycling stage. When AutoDelta is enabled for a cycling
stage, the settings are indicated by an icon in the thermal profile:

e AutoDelta on: &
e AutoDelta off: A

An analysis setting in which the software calculates the baseline start and end values for the
amplification plot. You can apply the automatic baseline setting to specific wells in the
reaction plate. See also baseline.

An analysis setting in which the software calculates the baseline start and end values and
the threshold in the amplification plot. The software uses the baseline and threshold to
calculate the threshold cycle (Cy). See also threshold cycle (CT).

baseline In the amplification plot, a line fit to the fluorescence levels during the initial stages of PCR,
when there is little change in fluorescence.
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baseline-corrected
normalized reporter
(ARN)

biological replicates

blocked IPC

o
calibrator
chemistry

comparative C;
(AAC;) method

custom dye

cycle threshold

cycling stage

Glossary

The magnitude of normalized fluorescence generated by the reporter:

1. In experiments that contain data from real-time PCR, the magnitude of normalized
fluorescence generated by the reporter at each cycle during the PCR amplification. In
the ARn vs. Cycle amplification plot, ARn is calculated at each cycle as:

ARn (cycle) = Rn (cycle) — Rn (baseline), where Rn = normalized reporter

2. In genotyping experiments and presence/absence experiments, the difference in
normalized fluorescence generated by the reporter between the pre-PCR read and the
post-PCR read. In the allelic discrimination plot (genotyping experiments) and the
presence/absence plot (presence/absence experiments), ARn is calculated as:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized reporter
See also normalized reporter (Rn).

Reactions that contain identical components and volumes, but evaluate separate samples of
the same biological source (for example, samples from three different mice of the same
strain, or separate extractions of the same cell line or tissue sample).

See also technical replicates.

In presence/absence experiments, a reaction that contains IPC blocking agent, which blocks
amplification of the internal positive control (IPC). In the 7500/7500 Fast system software,
the task for the IPC target in wells that contain IPC blocking agent. See also negative
control-blocked IPC wells.

See threshold cycle (CT).
See reference sample.
See reagents.

Method for determining relative target quantity in samples. With the comparative C1 (AACy)
method, the 7500/7500 Fast system software measures amplification of the target and of the
endogenous control in samples and in a reference sample. Measurements are normalized
using the endogenous control. The software determines the relative quantity of target in
each sample by comparing normalized target quantity in each sample to normalized target
quantity in the reference sample.

Dye that is not supplied by Applied Biosystems. Custom dyes may be adapted for use in

experiments on the 7500/7500 Fast system. When using custom dyes, the custom dye
should be added to the Dye Library and a custom dye calibration performed.

See threshold cycle (CT).

In the thermal profile, a stage that is repeated. A cycling stage is also called an amplification
stage. For cycling stages, you can enable AutoDelta settings. See also amplification stage.
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data collection

delta Rn (ARnN)
derivative reporter
(-Rn’)

Design Wizard

diluent

Diluted Sample
Concentration (10X
for Reaction Mix)

dilution factor
dissociation curve
EFF%

endogenous control

endpoint read

experiment

A process during the instrument run in which an instrument component detects
fluorescence data from each well of the reaction plate. The instrument transforms the signal
to electronic data, and the data are saved in the experiment file. In the 7500/7500 Fast
system software, a data collection point is indicated by an icon in the thermal profile:

* Data collection on:

 Data collection off:
See baseline-corrected normalized reporter (DRn).

The negative first-derivative of the normalized fluorescence generated by the reporter
during PCR amplification. In the derivative reporter (—Rn”) vs. temperature melt curve, the
derivative reporter signal is displayed in the y-axis.

A feature in the 7500/7500 Fast system software that helps you set up your experiment by
guiding you through best practices as you enter your experiment design.

A reagent used to dilute a sample or standard before adding it to the PCR reaction. The
diluent can be water or buffer.

In the 7500/7500 Fast system software, a field displayed on the Sample Dilution
Calculations tab of the Reaction Setup screen. For this field, enter the sample concentration
you want to use to add to the reaction mix for all samples in the experiment. “10X for
Reaction Mix” indicates that the software assumes the sample or standard component of the
reaction mix is at a 10X concentration. For example, if the diluted sample concentration is
50.0 ng/uL (10X), the final sample concentration in the reaction is 5 ng/uL (1X).

See serial factor.
See melt curve.
See amplification efficiency (EFF%).

A target or gene that should be expressed at similar levels in all samples you are testing.
Endogenous controls are used in relative standard curve and comparative C; (AACy)
experiments to normalize fluorescence for the target you are quantifying. Housekeeping
genes can be used as endogenous controls. See also housekeeping gene.

See post-PCR read.

Refers to the entire process of performing a run using the 7500/7500 Fast system, including
setup, run, and analysis. The types of experiments you can perform using the
7500/7500 Fast systems:

* Quantitation - standard curve

* Quantitation - relative standard curve

* Quantitation - comparative C; (AACy)

* Melt curve

* Genotyping

* Presence/absence
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experiment name

experiment type

forward primer

holding stage

housekeeping gene

internal positive
control (IPC)

inventoried assays

IPC

IPC blocking agent
IPC+
made-to-order

assays

manual baseline

Glossary

Entered during experiment setup, the name that is used to identify the experiment.
Experiment names cannot exceed 100 characters and cannot include any of the following
characters: forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk
(*), question mark (?), quotation mark ("), vertical line (|), colon (:), or semicolon (;).

The type of experiment you are performing using the 7500/7500 Fast system:

+ Standard curve

» Comparative C; (AACy)

* Relative standard curve

* Melt curve (not available in the Design Wizard)
* Genotyping

* Presence/absence

The experiment type you select affects the setup, run, and analysis.

Oligonucleotide that flanks the 5" end of the amplicon. The reverse primer and the forward
primer are used together in PCR reactions to amplify the target.

In the thermal profile, a stage that includes one or more steps. You can add a holding stage
to the thermal profile to activate enzymes, to inactivate enzymes, or to incubate a reaction.

A gene that is involved in basic cellular functions and is constitutively expressed.
Housekeeping genes can be used as endogenous controls. See also endogenous control.

In presence/absence experiments, a short synthetic DNA template that is added to PCR
reactions. You can use the IPC to distinguish between true negative results (that is, the target
is absent in the samples) and negative results caused by PCR inhibitors, incorrect assay
setup, or reagent or instrument failure.

TagMan® Gene Expression Assays and TagMan® SNP Genotyping Assays that have been
previously manufactured, passed quality control specifications, and stored in inventory.

In presence/absence experiments, abbreviation for internal positive control (IPC). In the
7500/7500 Fast system software, the task for the IPC target in wells that contain the IPC and
do not contain IPC blocking agent. See also internal positive control (IPC).

Reagent added to PCR reactions to block amplification of the internal positive control
(IPC).

See negative control-IPC wells.
TagMan® Gene Expression Assays or TagMan® SNP Genotyping Assays that are
manufactured at the time of order. Only assays that pass manufacturing quality control

specifications are shipped.

An analysis setting in which you enter the baseline start and end values for the amplification
plot. You can apply the manual baseline setting to specific wells in the reaction plate.

manual C; An analysis setting in which you enter the threshold value and select whether to use
automatic baseline or manual baseline values. The software uses the baseline and the
threshold values to calculate the threshold cycle (Cy).
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melt curve

melt curve stage
melting temperature
(Tm)
multicomponent
plot

negative control

(NC)

negative control-
blocked IPC wells

negative control-
IPC wells

no amplification
control (NAC)

no template control
(NTC)

nonfluorescent
quencher-minor

groove binder (NFQ-
MGB)

normalized quantity

normalized reporter
(Rn)

omit well

outlier
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A plot of data collected during the melt curve stage. Peaks in the melt curve can indicate the
melting temperature (Tm) of the target or can identify nonspecific PCR amplification. In
the 7500/7500 Fast system software, you can view the melt curve as normalized reporter
(Rn) vs. temperature or as derivative reporter (—Rn”) vs. temperature. Also called
dissociation curve.

In the thermal profile, a stage with a temperature increment to generate a melt curve.

In melt curve experiments, the temperature at which 50% of the DNA is double-stranded
and 50% of the DNA is dissociated into single-stranded DNA. The Tm is displayed in the
melt curve.

A plot of the complete spectral contribution of each dye for the selected well(s) over the
duration of the PCR run.

In the 7500/7500 Fast system software, the task for targets or SNP assays in wells that
contain water or buffer instead of sample. No amplification of the target should occur in
negative control wells. Previously called no template control (NTC).

In presence/absence experiments, wells that contain IPC blocking agent instead of sample
in the PCR reaction. No amplification should occur in negative control-blocked IPC wells
because the reaction contains no sample and amplification of the IPC is blocked. Previously
called no amplification control (NAC).

In presence/absence experiments, wells that contain IPC template and buffer or water
instead of sample. Only the IPC template should amplify in negative control-IPC wells
because the reaction contains no sample. Previously called IPC+.

See negative control-blocked IPC wells.

See negative control (NC).

Molecules that are attached to the 3" end of TagMan® probes. When the probe is intact, the
nonfluorescent quencher (NFQ) prevents the reporter dye from emitting fluorescence.
Because the NFQ does not fluoresce, it produces lower background signals, resulting in
improved precision in quantitation. The minor groove binder (MGB) increases the melting
temperature (Tm) without increasing probe length. It also allows the design of shorter
probes.

Quantity of target divided by the quantity of endogenous control.

Fluorescence from the reporter dye normalized to the fluorescence of the passive reference.

An action that you perform before reanalysis to omit one or more wells from analysis.
Because no algorithms are applied to omitted wells, omitted wells contain no results.

For a set of data, a datapoint that is significantly smaller or larger than the others.
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passive reference

plate layout

point

positive control

post-PCR read

pre-PCR read

primer mix

primer/probe mix

pure dye

quantitation method

quantity

quencher

Glossary

A dye that produces fluorescence. Because the passive reference signal should be consistent
across all wells, it is used to normalize the reporter dye signal to account for non-PCR
related fluorescence fluctuations caused by minor well-to-well differences in concentrations
or volume. Normalization to the passive reference signal allows for high data precision.

An illustration of the grid of wells and assigned content in the reaction plate. In the
7500/7500 Fast system, the grid contains 8 rows and 12 columns.

In the 7500/7500 Fast system software, you can use the plate layout as a selection tool to
assign well contents, to view well assignments, and to view results. The plate layout can be
printed, included in a report, exported, and saved as a slide for a presentation.

One standard in a standard curve. The standard quantity for each point in the standard curve
is calculated based on the starting quantity and serial factor.

In genotyping experiments, a DNA sample with a known genotype, homozygous or
heterozygous. In the 7500/7500 Fast system software, the task for the SNP assay in wells
that contain a sample with a known genotype.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs after amplification. In genotyping experiments, fluorescence data collected during
the post-PCR read are displayed in the allelic discrimination plot and used to make allele
calls. In presence/absence experiments, fluorescence data collected during the post-PCR
read are displayed in the presence/absence plot and used to make detection calls. Also called
endpoint read.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs before amplification. The pre-PCR read is optional but recommended. Fluorescence
data collected during the pre-PCR read can be used to normalize fluorescence data collected
during the post-PCR read.

PCR reaction component that contains the forward primer and reverse primer designed to
amplify the target.

PCR reaction component that contains the primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

See custom dye and system dye.

In quantitation experiments, the method used to determine the quantity of target in the
samples. In 7500/7500 Fast systems, there are three types of quantitation methods: standard
curve, relative standard curve, and comparative Cy (AACy).

In quantitation experiments, the amount of target in the samples. Absolute quantity can refer
to copy number, mass, molarity, or viral load. Relative quantity refers to the fold-difference
between normalized quantity of target in the sample and normalized quantity of target in the
reference sample.

A molecule attached to the 3’ end of TagMan® probes to prevent the reporter from emitting
fluorescence while the probe is intact. With TagMan® reagents, a nonfluorescent quencher-
minor groove binder (NFQ-MGB) can be used as the quencher. With SYBR® Green
reagents, no quencher is used.
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QuickStart

R2 value

ramp

ramp speed

raw data plot

reaction mix

reagents

real-time PCR

reference sample

refSNP ID

regression
coefficients

108

A feature in 7500/7500 Fast systems that allows you to run an experiment without entering
plate setup information.

Regression coefficient calculated from the regression line in the standard curve. The R?
value indicates the closeness of fit between the standard curve regression line and the
individual C; data points from the standard reactions. A value of 1.00 indicates a perfect fit
between the regression line and the data points.

The rate at which the temperature changes during the instrument run. For the melt curve
step, the ramp can also be defined as a temperature increment. In the graphical view of
the thermal profile, the ramp is indicated by a diagonal line.

Speed at which the temperature ramp occurs during the instrument run. Available ramp
speeds include fast and standard.

* For optimal results using the fast ramp speed, Applied Biosystems recommends using
TagMan® Fast reagents in your PCR reactions.

 For optimal results using the standard ramp speed, Applied Biosystems recommends
using standard reagents in your PCR reactions.

IMPORTANT! TagMan Fast reagents are not supported for genotyping or
presence/absence experiments.

A plot of raw fluorescence (not normalized) for each optical filter.

A solution that contains all components to run the PCR reaction, except for the template
(sample, standard, or control).

The PCR reaction components you are using to amplify the target and to detect
amplification. Types of reagents used on the 7500/7500 Fast systems:

+ TagMan® reagents
+ SYBR® Green reagents
* Other reagents

Process of collecting fluorescence data during PCR. Data from the real-time PCR are used
to calculate results for quantitation experiments or to troubleshoot results for genotyping or
presence/absence experiments.

In relative standard curve and comparative C; (AAC;) experiments, the sample used as the
basis for relative quantitation results. Also called the calibrator.

Identifies the reference SNP (refSNP) cluster ID. Generated by the Single Nucleotide
Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National Center
for Biotechnology Information (NCBI). The refSNP ID can be used to search the Applied
Biosystems Store for an Applied Biosystems SNP Genotyping Assay. Also called an rs
number.

Values calculated from the regression line in standard curves, including the R? value, slope,
and y-intercept. You can use the regression coefficients to evaluate the quality of results
from the standards. See also standard curve.
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regression line

reject well

relative standard
curve method

replicate group
replicates

reporter
reverse primer
reverse
transcriptase

Rn

ROX™ dye

rs number

run method

sample

Sample DNA (10X)

Glossary

In standard curve and relative standard curve experiments, the best-fit line from the
standard curve. Regression line formula:

Cr=m [log (Qty)] +b
where m is the slope, b is the y-intercept, and Qty is the standard quantity.

See also regression coefficients.

An action that the software performs during analysis to remove one or more wells from
further analysis if a specific flag is applied to the well. Rejected wells contain results
calculated up to the point of rejection.

Method for determining relative target quantity in samples. With the relative standard curve
method, the 7500/7500 Fast system software measures amplification of the target and of the
endogenous control in samples, in a reference sample, and in a standard dilution series.
Measurements are normalized using the endogenous control. Data from the standard
dilution series are used to generate the standard curve. Using the standard curve, the
software interpolates target quantity in the samples and in the reference sample. The
software determines the relative quantity of target in each sample by comparing target
quantity in each sample to target quantity in the reference sample.

A set of identical reactions in an experiment.

See technical replicates or biological replicates.

Fluorescent dye used to detect amplification. If you are using TagMan® reagents, the
reporter dye is attached to the 5" end. If you are using SYBR® Green reagents, the reporter

dye is SYBR® Green dye.

An oligonucleotide that flanks the 3" end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

An enzyme that converts RNA to cDNA. Reverse transcriptase is added to the PCR reaction
to perform 1-step RT-PCR.

See normalized reporter (Rn).

A dye supplied by Applied Biosystems and precalibrated on the 7500/7500 Fast systems.
ROX dye is used as the passive reference.

See refSNP ID.

Definition of the reaction volume and the thermal profile for the 7500/7500 Fast instrument
run.

The template that you are testing.

In the 7500/7500 Fast system software, a reaction component displayed on the Reaction
Mix Calculations tab of the Reaction Setup screen. The software assumes the sample DNA
is added to the reaction mix at a 10X concentration. For example, if the reaction volume is
20 uL, the calculated volume of sample for 1 reaction is 2 uL.
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Sample Library

Sample or Standard
(10X)

sample/SNP assay
reaction

sample/target
reaction

serial factor

series

slope

SNP

SNP assay

SNP Assay Library

region of interest
(ROI) calibration

stage

standard

In the 7500/7500 Fast system software, a collection of samples. The Sample Library
contains the sample name and the sample color.

In the 7500/7500 Fast system software, a reaction component displayed on the Reaction
Mix Calculations tab of the Reaction Setup screen. The software assumes the sample or
standard is added to the reaction mix at a 10X concentration. For example, if the reaction
volume is 20 UL, the calculated volume of sample or standard for 1 reaction is 2 pL.

In genotyping experiments, the combination of which sample to test and which SNP assay
to perform in one PCR reaction. Each PCR reaction can contain only one sample and one
SNP assay.

In quantitation experiments, the combination of which sample to test and which target to
detect and quantify in one PCR reaction. In the Design Wizard, you can detect and quantify
only one target in one PCR reaction. Use Advanced Setup to detect and quantify more than
one target in one PCR reaction.

In the 7500/7500 Fast system software, a numerical value that defines the sequence of
quantities in the standard curve. The serial factor and the starting quantity are used to
calculate the standard quantity for each point in the standard curve. For example, if the
standard curve is defined with a serial factor of 1:10 or 10X, the difference between any 2
adjacent points in the curve is 10-fold.

See standard dilution series.

Regression coefficient calculated from the regression line in the standard curve. The slope
indicates the PCR amplification efficiency for the assay. A slope of —3.32 indicates 100%
amplification efficiency. See also amplification efficiency (EFF%) and regression line.

Abbreviation for single nucleotide polymorphism. The SNP can consist of a base difference
or an insertion or deletion of one base.

Used in genotyping experiments, a PCR reaction that contains primers to amplify the SNP
and two probes to detect different alleles.

In the 7500/7500 Fast system software, a collection of SNP assays to add to genotyping
experiments. The SNP assays in the library contain the SNP assay name, SNP assay color,
and for each allele, the allele name or base(s), reporter, quencher, and allele colors. The SNP
assays in the library may also contain the assay ID and comments about the SNP assay.

Type of 7500/7500 Fast system calibration in which the system maps the positions of the
wells in the sample block. ROI calibration data are used so that the software can associate
increases in fluorescence during a run with specific wells in the reaction plate.

In the thermal profile, a group of one or more steps. There are three types of stages: holding
stage (including pre-PCR read and post-PCR read), cycling stage (also called amplification
stage), and melt curve stage.

Sample that contains known standard quantities. Standard reactions are used in quantitation
experiments to generate standard curves. See also standard curve and standard dilution
series.
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standard curve

standard curve
method

standard dilution
series

standard quantity

starting quantity

Glossary

In standard curve and relative standard curve experiments:

* The best-fit line in a plot of the C; values from the standard reactions plotted against
standard quantities. See also regression line.

* A set of standards containing a range of known quantities. Results from the standard
curve reactions are used to generate the standard curve. The standard curve is defined
by the number of points in the dilution series, the number of standard replicates, the
starting quantity, and the serial factor. See also standard dilution series.

Method for determining absolute target quantity in samples. With the standard curve
method, the 7500/7500 Fast system software measures amplification of the target in
samples and in a standard dilution series. Data from the standard dilution series are used to
generate the standard curve. Using the standard curve, the software interpolates the absolute
quantity of target in the samples. See also standard and standard curve.

In standard curve and relative standard curve experiments, a set of standards containing a
range of known quantities. The standard dilution series is prepared by serially diluting
standards. For example, the standard stock is used to prepare the first dilution point, the first
dilution point is used to prepare the second dilution point, and so on. In the 7500/7500 Fast
system software, the volumes needed to prepare a standard dilution series are calculated by
the number of dilution points, the number of standard replicates, the starting quantity, the
serial factor, and the standard concentration in the stock. See also standard curve.

A known quantity in the PCR reaction.

* In standard curve experiments, the quantity of target in the standard. In the
7500/7500 Fast system software, the units for standard quantity can be for mass, copy
number, viral load, or other units for measuring the quantity of target.

* Inrelative standard curve experiments, a known quantity in the standard. Standard
quantity can refer to the quantity of cDNA or the quantity of standard stock in the
PCR reaction. The units are not relevant for relative standard curve experiments
because they cancel out in the calculations.

When defining a standard curve in the 7500/7500 Fast system software, corresponds to the
highest or lowest quantity.

step A component of the thermal profile. For each step in the thermal profile, you can set the
ramp rate (ramp increment for melt curve steps), hold temperature, hold time (duration),
and you can turn data collection on or off for the ramp or the hold parts of the step. For
cycling stages, a step is also defined by the AutoDelta status.

SYBR® Green PCR reaction components that consist of two primers designed to amplify the target and

reagents SYBR® Green dye to detect double-stranded DNA.
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system dye

TagMan® reagents

target

target color

Target Library

task

technical replicates

112

Dye supplied by Applied Biosystems and precalibrated on the 7500/7500 Fast system.
Before you use system dyes in your experiments, make sure the system dye calibration is
current in the Instrument Maintenance Manager.

System dyes of the 7500/7500 Fast system include:
+ FAM"™ dye
+ JOE™ dye
« NED" dye
« ROX™ dye
+ SYBR® Green dye
« TAMRA™ dye
+ VIC® dye
* CY3dye
+ CYS5dye
+ TEXAS RED® dye

PCR reaction components that consist of primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

The nucleic acid sequence that you want to amplify and detect.

In the 7500/7500 Fast system software, a color assigned to a target to identify the target in
the plate layout and analysis plots.

In the 7500/7500 Fast system software, a collection of targets to add to experiments. The
targets in the library contain the target name, reporter, quencher, and target color. The target
in the library may also contain comments about the target.

In the 7500/7500 Fast system software, the type of reaction performed in the well for the
target or SNP assay. Available tasks:

» Unknown

* Negative Control

 Standard (standard curve and relative standard curve experiments)
* Positive control (genotyping experiments)

+ [PC (presence/absence experiments)

* Blocked IPC (presence/absence experiments)

Identical reactions that contain identical components and volumes and evaluate the same
sample.

See also biological replicates.
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template

thermal profile

threshold

threshold cycle (C,)

Tm

unknown

unknown-IPC wells

Glossary

In the Design Wizard of the 7500/7500 Fast system software (and in QuickStart for
quantitation experiments), the type of nucleic acid to add to the PCR reaction. The
recommended template varies according to experiment type:

Quantitation experiments (standard curve, relative standard curve, and comparative
C;) — cDNA (complementary cDNA), RNA, or gDNA (genomic DNA)

For quantitation experiments, the template type selection affects the run method,
reaction setup, and materials list.

Genotyping experiments — Wet DNA (gDNA or cDNA) or dry DNA (gDNA or
cDNA)

For genotyping experiments, the template type selection affects the reaction setup.
Presence/absence experiments - DNA

For presence/absence experiments, Applied Biosystems recommends adding DNA
templates to the PCR reactions.

Part of the run method that specifies the temperature, time, ramp, and data collection points
for all steps and stages of the 7500/7500 Fast instrument run.

1.

In amplification plots, the level of fluorescence above the baseline and within the
exponential growth region The threshold can be determined automatically (see
automatic CT) or can be set manually (see manual CT).

In presence/absence experiments, the level of fluorescence above which the
7500/7500 Fast system software assigns a presence call.

The PCR cycle number at which the fluorescence meets the threshold in the amplification

plot.

See melting temperature (Tm).

In the 7500/7500 Fast system software, the task for the target or SNP assay in wells that
contain the sample you are testing:

In quantitation experiments, the task for the target in wells that contain a sample with
unknown target quantities.

In genotyping experiments, the task for the SNP assay in wells that contain a sample
with an unknown genotype.

In presence/absence experiments, the task for the target in wells that contain a sample
in which the presence of the target is not known.

In presence/absence experiments, wells that contain a sample and internal positive control

(IPC).
y-intercept In the standard curve, the value of y where the regression line crosses the y-axis. The
y-intercept indicates the expected threshold cycle (C;) for a sample with quantity equal to 1.
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alternate experiment workflows. See workflows.
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baseline analyze 62

correct values 71 description 11, 23

examples 73 name 18
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Also see materials required 4
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succeeded 75 QC. Summary 82
threshold 66 QuickStart 11, 109
L R
library 26 radioactive waste, handling 15

reaction mix

load ti late 51
oad reaction plate prepare 27, 42

reaction plate
M layourz 12
Methods and Materials screen 20 load 51
monitor run unload from the instrument 57
Amplification Plot screen 55 reaction plates 6
Run Method screen 56 Reaction Setup screen 27
moving and lifting, safety 12 reaction volume 25
moving parts, safety 16 reagents
MSDSs other fluorescent-based 8
description 13 supported 8
obtaining 13 TagMan 8
MSDSs, obtaining 7 repetitive motion, safety 17
multicomponent plot 86 ROX dye 86
multiple plots, viewing 64 run experiment
alerts 57
N enable notification settings 53
for more information 57
negative control 67, 75, 87 guidelines 54
negative control - blocked IPC 23 monitor 55
negative control - IPC 23 Is)tr;rlzarsesfor Sl
NOAMP 83 workflow 50
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NOSIGNAL 83 Run Method screen 25
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before operating the instrument 12

biological hazards 17
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conventions 8
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guidelines 14, 15
instrument operation 12

moving and lifting instrument 12

moving parts 16
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repetitive motion 17
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safety labels, on instruments 10
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sample dilutions 42
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SPIKE 83

standard deviation, effect of threshold on 72

standard vs. fast plates 6

standards
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safety 18

SYBR Green reagents 3, 89
symbols, safety 9

T

TagqMan reagents 3, 8, 20, 21, 89

target
calls 67
name 39
threshold 66

Targets screen 22

Technical Support, contacting 7
Template 11, 111

template 39
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THOLDFAIL 83

threshold
correct values 71
examples 72

threshold, adjusting 81
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troubleshooting
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adjust baseline 81

adjust threshold 81

flags 81, 83

omit wells 84

view multicomponent plot 86
view QC summary 82

view raw data plot 88

U

unconfirmed call 66, 75
unknown - IPC 23
unload instrument 57
user attention words, described 4
using this guide

as a tutorial 11

with your own experiments 11

Vv
VIC dye 86

W

WARNING, description 8
waste disposal, guidelines 15
Well Table, viewing 74

wells
negative control 23, 87
omitting 84
selecting 33, 63
unknown 23

workflows
Advanced Setup 108
example experiment 14
Export/Import 11, 112
QuickStart 11, 109
Template 11, 111
tutorial 11

workstation safety 17
Numerics

7500/7500 Fast system
about 2
consumables 4
data collection 2
filters 3, 89
A
Advanced Setup 8, 11, 92
alternate experiment workflows. See work-
flows.
amplification curve 71
amplification plot
viewing 68
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monitor during a run 55
AMPNC 83
analysis settings
baseline 81
call settings 81
flag settings 81
threshold 81
viewing 80
Applied Biosystems 7500/7500 Fast Real-Time
PCR System. See 7500/7500 Fast system.
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BADROX 83
baseline
correct values 71
examples 73
BLFAIL 83
blocked IPC 75
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consumables 39
Also see materials required 4
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create an experiment
example experiment 17
CT Settings 81
CTFAIL 83
curves, amplification 71
D
data
about data collection 2
design experiment
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define methods and materials 20
design wizard
finish design wizard 33
deviation, standard 72
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Export/Import 11, 96
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FAM dye 86
flags 81, 83
G
guidelines
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inventoried/made to order 27
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failed 75
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threshold 66
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load reaction plate 51
M
Methods and Materials screen 20
monitor run
Amplification Plot screen 55
Run Method screen 56
multicomponent plot 86
multiple plots, viewing 64
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negative control 67, 75, 87
negative control - blocked IPC 23
negative control - [PC 23
NOAMP 83
NOISE 83
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notification settings 53
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E omit wells 84
example experiment other fluorescent-based reagents 8
analyze 62 P
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name 18 prepare for run 51
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run 50 about 7
sample dilutions 42 flags 83
template 12 materials 31
workflow 14 plot 65
EXPFAIL 83 presence/absence example experiment
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